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´»Ï ²°Èµ¹ ±µ·¾¿°Á½¾ÁÂ¸ ¾×ÝÐÚÞÜìâÕáì á ßàÕÔÛÐÓÐÕÜëÜØ 
×ÔÕáì ßàÞáâëÜØ ßàÐÒØÛÐÜØ. ½ÐàãèÕÝØÕ íâØå ßàÐÒØÛ ÜÞÖÕâ 
ßàÕÔáâÐÒÛïâì ÞßÐáÝÞáâì ØÛØ ßàÕáÛÕÔãÕâáï ßÞ ×ÐÚÞÝã. ±ÞÛÕÕ 
ßÞÔàÞÑÝÐï ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ Ò ÞâÔÕÛìÝÞÜ àãÚÞÒÞÔáâÒÕ ßÞ 
íÚáßÛãÐâÐæØØ.

¿µÀ²¾ÁÂµ¿µ½½¾µ ·½°Çµ½¸µ ¸¼µµÂ ±µ·¾¿°Á½¾ÁÂÌ
´¾À¾¶½¾³¾ ´²¸¶µ½¸Ï ½Õ ßÞÛì×ãÙâÕáì ÚÞÜÜãÝØÚÐâÞàÞÜ ÒÞ 
ÒàÕÜï ãßàÐÒÛÕÝØï ÐÒâÞÜÞÑØÛÕÜ - áÝÐçÐÛÐ ÞáâÐÝÞÒØâÕ ÐÒâÞÜÞÑØÛì.

À°´¸¾¿¾¼µÅ¸ ²áÕ ÑÕáßàÞÒÞÔÝëÕ àÐÔØÞâÕÛÕäÞÝë ßÞÔÒÕàÖÕÝë 
ÒÞ×ÔÕÙáâÒØî àÐÔØÞßÞÜÕå, ÚÞâÞàëÕ ÜÞÓãâ ãåãÔèØâì ÚÐçÕáâÒÞ Øå 
àÐÑÞâë.

²Ëº»ÎÇ°¹Âµ À°´¸¾Âµ»µÄ¾½ ² ±¾»Ì½¸Æ°Å ÁÞÑÛîÔÐÙâÕ ÒáÕ 
ãáâÐÝÞÒÛÕÝÝëÕ ßàÐÒØÛÐ Ø ØÝáâàãÚæØØ. ²ëÚÛîçÐÙâÕ àÐÔØÞâÕÛÕäÞÝ 
ßàØ ÝÐåÞÖÔÕÝØØ àïÔÞÜ á ÜÕÔØæØÝáÚØÜ ÞÑÞàãÔÞÒÐÝØÕÜ.

²Ëº»ÎÇ°¹Âµ À°´¸¾Âµ»µÄ¾½ ² Á°¼¾»µÂµ ÀÐÔØÞâÕÛÕäÞÝ 
ÜÞÖÕâ áÞ×ÔÐÒÐâì àÐÔØÞßÞÜÕåØ. ¿ÞÛì×ÞÒÐÝØÕ àÐÔØÞâÕÛÕäÞÝÞÜ 
Ò áÐÜÞÛÕâÕ ÞäØæØÐÛìÝÞ ×ÐßàÕéÕÝÞ.

²Ëº»ÎÇ°¹Âµ À°´¸¾Âµ»µÄ¾½ ½° °²Â¾·°¿À°²¾Ç½ËÅ
ÁÂ°½Æ¸ÏÅ ½Õ ßÞÛì×ãÙâÕáì àÐÔØÞâÕÛÕäÞÝÞÜ ÝÐ ÐÒâÞ×ÐßàÐÒÞçÝëå 
áâÐÝæØïå. ½Õ ØáßÞÛì×ãÙâÕ àÐÔØÞâÕÛÕäÞÝ ÒÑÛØ×Ø âÞßÛØÒÝëå ØÛØ 
åØÜØçÕáÚØå ÞÑêÕÚâÞÒ.



²Ëº»ÎÇ°¹Âµ Âµ»µÄ¾½ ² ¼µÁÂ°Å ²Ë¿¾»½µ½¸Ï ²·ÀË²½ËÅ
À°±¾Â ½Õ ßÞÛì×ãÙâÕáì àÐÔØÞâÕÛÕäÞÝÞÜ Ò ÜÕáâÐå ßàÞÒÕÔÕÝØï 
Ò×àëÒÝëå àÐÑÞâ. ÁÞÑÛîÔÐÙâÕ ÒáÕ ãáâÐÝÞÒÛÕÝÝëÕ ÞÓàÐÝØçÕÝØï, ßàÐÒØÛÐ 
Ø ØÝáâàãÚæØØ.

¿À°²¸»Ì½¾ ¿¾»Ì·Ã¹ÂµÁÌ À°´¸¾Âµ»µÄ¾½¾¼ ²Þ ÒàÕÜï àÐ×ÓÞÒÞàÐ 
àÐÔØÞâÕÛÕäÞÝ ßÞáâÞïÝÝÞ ÔÞÛÖÕÝ ÝÐåÞÔØâìáï Ò ÞÑëçÝÞÜ àÐÑÞçÕÜ 
ßÞÛÞÖÕÝØØ (ßÞÔÝÕáÕÝÝëÜ Ú ãåã). ½Õ áÛÕÔãÕâ ÑÕ× ÝÕÞÑåÞÔØÜÞáâØ 
ßàØÚÐáÐâìáï Ú ÐÝâÕÝÝÕ.

¾±À°É°¹ÂµÁÌ º º²°»¸Ä¸Æ¸À¾²°½½Ë¼ Á¿µÆ¸°»¸ÁÂ°¼ 

º àÐÑÞâÐÜ ßÞ ÜÞÝâÐÖã Ø àÕÜÞÝâã ÞÑÞàãÔÞÒÐÝØï ÝÕÞÑåÞÔØÜÞ ÔÞßãáÚÐâì 
ÛØèì ÚÒÐÛØäØæØàÞÒÐÝÝëå áßÕæØÐÛØáâÞÒ.

°ºÁµÁÁÃ°ÀË ¸ °ººÃ¼Ã»ÏÂ¾À½Ëµ ±°Â°Àµ¸ ¿ÞÛì×ãÙâÕáì âÞÛìÚÞ 
ÐßàÞÑØàÞÒÐÝÝëÜØ ÐÚáÕááãÐàÐÜØ Ø ÐÚÚãÜãÛïâÞàÐÜØ. ½Õ ßÞÔÚÛîçÐÙâÕ 
ÝÕáÞÒÜÕáâØÜëÕ ãáâàÞÙáâÒÐ.

¿¾ÁË»º° Âµ»µÄ¾½½ËÅ ²Ë·¾²¾² ·ÐÚàÞÙâÕ ÚàëèÚã Ø ãÑÕÔØâÕáì, çâÞ 
âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï. ½ÐÑÕàØâÕ 
âÕÛÕäÞÝÝëÙ ÝÞÜÕà (ÒÚÛîçÐï ÜÕÖÔãÓÞàÞÔÝëÙ ÚÞÔ) Ø ÝÐÖÜØâÕ . 
·ÐÒÕàèÕÝØÕ áÒï×Ø ÞáãéÕáâÒÛïÕâáï ÝÐÖÐâØÕÜ . ´Ûï ÞâÒÕâÐ ÝÐ Òë×ÞÒ 
ÝÐÖÜØâÕ .

²Ë·¾² Á»Ã¶±Ë ÍºÁÂÀµ½½¾¹ ¿¾¼¾É¸ ·ÐÚàÞÙâÕ ÚàëèÚã 
âÕÛÕäÞÝÐ. ÃÑÕÔØâÕáì Ò âÞÜ, çâÞ âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï Ò ×ÞÝÕ 
ÞÑáÛãÖØÒÐÝØï. ´Ûï ÞçØáâÚØ ÔØáßÛÕï ÝÐÖÜØâÕ ÝÐ ÝÕáÚÞÛìÚÞ áÕÚãÝÔ 
ÚÛÐÒØèã . ½ÐÑÕàØâÕ âÕÛÕäÞÝÝëÙ ÝÞÜÕà íÚáâàÕÝÝÞÙ áÛãÖÑë Ø ßÞáÛÕ 
íâÞÓÞ ÝÐÖÜØâÕ . ÁÞÞÑéØâÕ áÒÞØ ÚÞÞàÔØÝÐâë. ½Õ ßàÕàëÒÐÙâÕ áÒï×ì 
ÑÕ× áÞÓÛÐáÞÒÐÝØï á ÐÑÞÝÕÝâÞÜ ÝÐ ÔàãÓÞÜ ÚÞÝæÕ áÞÕÔØÝÕÝØï.



·°¿°Á°¹ÂµÁÌ Àµ·µÀ²½Ë¼¸ º¾¿¸Ï¼¸ ½Õ ×ÐÑëÒÐÙâÕ 
ÚÞßØàÞÒÐâì ÒáÕ ×ÝÐçØÜëÕ ÔÐÝÝëÕ.

¿¾´º»ÎÇµ½¸µ º ´ÀÃ³¸¼ ÃÁÂÀ¾¹ÁÂ²°¼ ´Þ ßÞÔÚÛîçÕÝØï 
Ú ÛîÑÞÜã ÔàãÓÞÜã ãáâàÞÙáâÒã Þ×ÝÐÚÞÜìâÕáì Ò àãÚÞÒÞÔáâÒÕ ßÞ ÕÓÞ 
ØáßÞÛì×ÞÒÐÝØî á ßÞÔàÞÑÝëÜØ ØÝáâàãÚæØïÜØ ßÞ ÞÑÕáßÕçÕÝØî 
ÑÕ×ÞßÐáÝÞáâØ. ½Õ ßÞÔÚÛîçÐÙâÕ ÝÕáÞÒÜÕáâØÜëÕ Ø×ÔÕÛØï.

¼µÀË ¿Àµ´¾ÁÂ¾À¾¶½¾ÁÂ¸ ² ¾Â½¾Èµ½¸¸ ¸½ÄÀ°ºÀ°Á½¾³¾
¸·»ÃÇµ½¸Ï ÁÛÕÔØâÕ ×Ð âÕÜ, çâÞÑë ØÝäàÐÚàÐáÝëÙ Ûãç ÝÕ ÑëÛ 
ÝÐßàÐÒÛÕÝ Ò çÕÙ-ÛØÑÞ ÓÛÐ× Ø ÝÕ ßÕàÕáÕÚÐÛáï á ØÝäàÐÚàÐáÝëÜØ 
ÛãçÐÜØ ÔàãÓØå ãáâàÞÙáâÒ Ò àÕÖØÜÕ Ò×ÐØÜÝëå ßÞÜÕå.
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àãÚÞÒÞÔáâÒÞ
¿ÞáÛÕ àÐáßÐÚÞÒÚØ ÚÞÜßÛÕÚâÐ ßàÞÒÕàìâÕ ÝÐÛØçØÕ ßÕàÕçØáÛÕÝÝëå ÝØÖÕ 
ÚÞÜßÞÝÕÝâÞÒ:

• ºÞÜÜãÝØÚÐâÞà Nokia 9210 Communicator
• ºÐàâÐ ßÐÜïâØ
• ÀãÚÞÒÞÔáâÒÞ ßÞ íÚáßÛãÐâÐæØØ, ãáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì (Settings checklist), 

ÞÑêÕÔØÝÕÝÝÞÕ ÚàÐâÚÞÕ àãÚÞÒÞÔáâÒÞ Ø àãÚÞÒÞÔáâÒÞ ßÞ ßàØÝÐÔÛÕÖÝÞáâïÜ, Ð 
âÐÚÖÕ àãÚÞÒÞÔáâÒÞ ßÞ ÔÞßÞÛÝØâÕÛìÝëÜ ßàØÛÞÖÕÝØïÜ (Add-on applications 
guide)

• °ÚÚãÜãÛïâÞà ßÞÒëèÕÝÝÞÙ ÕÜÚÞáâØ BLL-3
• ·ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-9
• ºÐÑÕÛì ØÝâÕàäÕÙáÐ RS-232 DLR-2L
• ºÞÜßÐÚâ-ÔØáÚ á ßàÞÓàÐÜÜÝëÜ ÞÑÕáßÕçÕÝØÕÜ áÒï×Ø á ¿º
• ½ÐÚÛÕÙÚØ á áÕàØÙÝëÜ ÝÞÜÕàÞÜ Ø ÚÞÔÞÜ ÑÛÞÚØàÞÒÚØ ÚÞÜÜãÝØÚÐâÞàÐ
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Þ ÃáÛÞÒØï, ÝÕÞÑåÞÔØÜëÕ ÔÛï àÐÑÞâë 
âÕÛÕäÞÝÐ

ÁÞÒÕâ. ´Ûï âÞÓÞ, çâÞÑë 
ÒÞáßÞÛì×ÞÒÐâìáï 
ØÝâÕàÐÚâØÒÝÞÙ áßàÐÒÚÞÙ, 
ÞâÚàÞÙâÕ ÚàëèÚã Ø 
ÝÐÖÜØâÕ ÚÛÐÒØèã  
(ÁßàÐÒÚÐ).

´Ûï ßÞáëÛÚØ Ø ßàØÕÜÐ âÕÛÕäÞÝÝëå Òë×ÞÒÞÒ Ø áÞÞÑéÕÝØÙ á ßÞÜÞéìî 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210 Communicator ÝÕÞÑåÞÔØÜÞ áÛÕÔãîéÕÕ:

• âÕÛÕäÞÝ ÒÚÛîçÕÝ;
• Ò âÕÛÕäÞÝ ãáâÐÝÞÒÛÕÝÐ ÔÕÙáâÒãîéÐï SIM-ÚÐàâÐ;
• âÕÛÕäÞÝ ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ.

² ÝÕÚÞâÞàëå áÞâÞÒëå áÕâïå Òë×ÞÒë ßÞ ÜÕÖÔãÝÐàÞÔÝÞÜã ÝÞÜÕàã áÛãÖÑë 
íÚáâàÕÝÝÞÙ ßÞÜÞéØ 112 ÔÞßãáÚÐîâáï Ø ÑÕ× SIM-ÚÐàâë. ´ÞßÞÛÝØâÕÛìÝãî 
ØÝäÞàÜÐæØî ÜÞÖÝÞ ßÞÛãçØâì ã ÞßÕàÐâÞàÐ áÞâÞÒÞÙ áÕâØ.

¿ÕàÒÞÕ ÒÚÛîçÕÝØÕ
¿àØÜÕçÐÝØÕ. ¼ØÝØÐâîàÝëÕ ÚÐàâÞçÚØ SIM áÛÕÔãÕâ ÔÕàÖÐâì âÞÛìÚÞ Ò ÝÕ 

ÔÞáâãßÝëå ÔÛï ÔÕâÕÙ ÜÕáâÐå.

1 ·ÐÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ Ø ãÑÕÔØâÕáì Ò âÞÜ, çâÞ âÕÛÕäÞÝ 
ÒëÚÛîçÕÝ. ² ßàÞâØÒÝÞÜ áÛãçÐÕ ÝÐÖÜØâÕ .

2 µáÛØ Ò ÚÞÜÜãÝØÚÐâÞà ãáâÐÝÞÒÛÕÝ ÐÚÚãÜãÛïâÞà, ÞâáÞÕÔØÝØâÕ ÕÓÞ. ½ÐÖÜØâÕ 
äØÚáÐâÞà Ò ÒÕàåÝÕÙ çÐáâØ ÐÚÚãÜãÛïâÞàÐ Ø ßÞÔÝØÜØâÕ ÐÚÚãÜãÛïâÞà Ø× 
ÓÝÕ×ÔÐ. ÁÜ. àØá. 1.
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ÀØá. 1

3 ÃáâÐÝÞÒØâÕ SIM-ÚÐàâã Ò ÓÝÕ×ÔÞ SIM-ÚÐàâë: ßÞ×ÞÛÞçÕÝÝëÕ ÚÞÝâÐÚâë SIM-
ÚÐàâë ÔÞÛÖÝë Ñëâì ÞÑàÐéÕÝë ÒÝØ×, Ð áÚÞèÕÝÝëÙ ãÓÞÛ ÚÐàâë ÔÞÛÖÕÝ 
ÞÚÐ×Ðâìáï áßàÐÒÐ. ÁÜ. àØá. 2.
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ÀØá. 2

µáÛØ SIM-ÚÐàâÐ ßàÐÒØÛìÝÞ ãáâÐÝÞÒÛÕÝÐ Ò ÓÝÕ×ÔÞ, áÚÞèÕÝÝëÙ ãÓÞÛ ÞáâÐÕâáï 
áÝÐàãÖØ, ÚÐÚ ßÞÚÐ×ÐÝÞ ÝÐ àØá. 3.

ÀØá. 3 ÒØÔÕÝ áÚÞèÕÝÝëÙ ãÓÞÛ
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Þ4 ÃÑÕÔØâÕáì Ò âÞÜ, çâÞ SIM-ÚÐàâÐ àÐáßÞÛÞÖÕÝÐ ßàÐÒØÛìÝÞ, Ø ãáâÐÝÞÒØâÕ ÝÐ 

ÜÕáâÞ ÐÚÚãÜãÛïâÞà. µáÛØ ÐÚÚãÜãÛïâÞà ×ÐàïÖÕÝ ÝÕ ßÞÛÝÞáâìî ØÛØ ÝÕ 
×ÐàïÖÕÝ áÞÒáÕÜ, ßÕàÕÔ ÒÚÛîçÕÝØÕÜ ÚÞÜÜãÝØÚÐâÞàÐ àÕÚÞÜÕÝÔãÕâáï 
ßÞÔÚÛîçØâì Ú ÝÕÜã ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ø ÝÐçÐâì ×ÐàïÔÚã ÐÚÚãÜãÛïâÞàÐ. 

5 ¾âÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ. ºÞÜÜãÝØÚÐâÞà ÒëßÞÛÝïÕâ 
áÐÜÞßàÞÒÕàÚã, Ò âÕçÕÝØÕ ÚÞâÞàÞÙ ÝÐ ÔØáßÛÕÕ ÞâÞÑàÐÖÐÕâáï íÚàÐÝ 
ßàØÒÕâáâÒØï.

6 µáÛØ ÚÞÜÜãÝØÚÐâÞà ßÞÔÔÕàÖØÒÐÕâ ÒëÑÞà àÐáÚÛÐÔÞÚ ÚÛÐÒØÐâãàë, ßÞáÛÕ 
×ÐÒÕàèÕÝØï áÐÜÞßàÞÒÕàÚØ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï ×ÐßàÞá ÝÐ ÒëÑÞà 
àÐáÚÛÐÔÚØ ÚÛÐÒØÐâãàë. ½ÐÖÜØâÕ ¾º ÔÛï ßÞÔâÒÕàÖÔÕÝØï ÒëÑÞàÐ 
àÐáÚÛÐÔÚØ.
² ßàÞâØÒÝÞÜ áÛãçÐÕ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï áßØáÞÚ ÓÞàÞÔÞÒ.

ÁÞÒÕâ. ²ëÑàÐâì áÒÞÙ 
ÓÞàÞÔ, çÐáÞÒÞÙ ßÞïá, 
äÞàÜÐâ ÒàÕÜÕÝØ Ø ÔÐâë 
ÜÞÖÝÞ Ò ÛîÑÞÕ ÒàÕÜï 
á ßÞÜÞéìî ßàØÛÞÖÕÝØÙ 
Clock (ÇÐáë) Ø Control 
panel (¿ÐÝÕÛì 
ãßàÐÒÛÕÝØï).

7 Á ßÞÜÞéìî ÚÛÐÒØè áÞ áâàÕÛÚÐÜØ ßàÞÚàãâØâÕ áßØáÞÚ ÔÞ áÒÞÕÓÞ ÓÞàÞÔÐ Ø 
ÝÐÖÜØâÕ OK. ¾âÚàÞÕâáï íÚàÐÝ, áÞÔÕàÖÐéØÙ âÕÚãéÕÕ ÒàÕÜï Ø ÔÐâã.
´Ûï ßÞØáÚÐ ÓÞàÞÔÐ ÜÞÖÝÞ ×ÐßÞÛÝØâì áâàÞÚã ßÞØáÚÐ Ò ßÞÛÕ ßÞØáÚÐ Ò ÝØÖÝÕÙ 
çÐáâØ íÚàÐÝÐ.

8 ¸×ÜÕÝØâÕ ÔÐâã Ø ÒàÕÜï, ÕáÛØ âàÕÑãÕâáï, Ø ÝÐÖÜØâÕ OK.

ÁÞÒÕâ. ´Ûï 
ßàØáÞÕÔØÝÕÝØï ÚÐàâØÝÚØ 
Ú áÒÞÕÙ ÒØ×ØâÝÞÙ ÚÐàâÞçÚÕ 
ÜÞÖÝÞ Ò ÛîÑÞÕ ÒàÕÜï 
ÒÞáßÞÛì×ÞÒÐâìáï 
ßàØÛÞÖÕÝØÕÜ Contacts 
(ºÞÝâÐÚâë).

9 ·ÐâÕÜ ÜÞÖÝÞ Ø×ÜÕÝØâì ßÕàáÞÝÐÛìÝãî ØÝäÞàÜÐæØî ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ. 
½ÐÖÜØâÕ OK.
µáÛØ Ò ÚÞÜÜãÝØÚÐâÞà ãáâÐÝÞÒÛÕÝÐ ÔÕÙáâÒãîéÐï SIM-ÚÐàâÐ, ØÝäÞàÜÐæØï 
ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ ÜÞÖÕâ Ñëâì Ø×ÒÛÕçÕÝÐ á SIM-ÚÐàâë.

10 ½Ð íÚàÐÝÕ ßÞïÒØâáï áÞÞÑéÕÝØÕ ÞÑ ãáßÕèÝÞÜ ×ÐÒÕàèÕÝØØ ßÕàÒÞÓÞ 
ÒÚÛîçÕÝØï. ½ÐÖÜØâÕ OK.
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Þ ¿àØÜÕçÐÝØÕ. °ÚÚãÜãÛïâÞà ÝÕ ÒáâÐÝÕâ ÝÐ ÜÕáâÞ, ÕáÛØ SIM-ÚÐàâÐ 
ãáâÐÝÞÒÛÕÝÐ ÝÕßàÐÒØÛìÝÞ. ¿àØ ãáâÐÝÞÒÚÕ ÐÚÚãÜãÛïâÞàÐ ÝÕ 
ßàØÛÐÓÐÙâÕ çàÕ×ÜÕàÝëå ãáØÛØÙ! ÃÑÕÔØâÕáì Ò âÞÜ, SIM-ÚÐàâÐ 
ßàÐÒØÛìÝÞ ãáâÐÝÞÒÛÕÝÐ Ò ÓÝÕ×ÔÞ, ÚÐÚ ãÚÐ×ÐÝÞ ÒëèÕ. µáÛØ 
SIM-ÚÐàâÐ ãáâÐÝÞÒÛÕÝÐ ÝÕßàÐÒØÛìÝÞ, ÒëâïÝØâÕ ÕÕ Ø× ÓÝÕ×ÔÐ 
Ø ãáâÐÝÞÒØâÕ áÝÞÒÐ.

·ÐàïÔÚÐ ÐÚÚãÜãÛïâÞàÐ
ÁÞÒÕâ. ÂÕÚãéÕÕ 

áÞáâÞïÝØÕ ÐÚÚãÜãÛïâÞàÐ 
ÞâÞÑàÐÖÐÕâáï ÝÐ 
ØÝÔØÚÐâÞàÕ ãàÞÒÝï 
×ÐàïÔÚØ  ÝÐ ÔØáßÛÕÕ 
ÚÞÜÜãÝØÚÐâÞàÐ ØÛØ 
âÕÛÕäÞÝÐ.

1 ¿ÞÔÚÛîçØâÕ ßàÞÒÞÔ ×ÐàïÔÝÞÓÞ ãáâàÞÙáâÒÐ Ú àÐ×êÕÜã Ò ÝØÖÝÕÙ çÐáâØ 
ÚÞÜÜãÝØÚÐâÞàÐ, ÚÐÚ ßÞÚÐ×ÐÝÞ ÝÐ àØá. 4.

ÀØá. 4

2 ²ÚÛîçØâÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ò áÕâÕÒãî àÞ×ÕâÚã (á áÞÞâÒÕâáâÒãîéØÜ 
ÝÐßàïÖÕÝØÕÜ). ² ßàÞæÕááÕ ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ßÞÚÐ×ÐÝØï ØÝÔØÚÐâÞàÐ 
ãàÞÒÝï ×ÐàïÔÚØ ÝÐ ÔØáßÛÕÕ âÕÛÕäÞÝÐ æØÚÛØçÕáÚØ Ø×ÜÕÝïîâáï.
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Þ3 ¿Þ ÔÞáâØÖÕÝØØ ßÞÛÝÞÙ ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ßÞÚÐ×ÐÝØï ØÝÔØÚÐâÞàÐ 

ßÕàÕáâÐîâ Ø×ÜÕÝïâìáï, Ø ÞâÞÑàÐÖÐîâáï ÒáÕ çÕâëàÕ íÛÕÜÕÝâÐ èÚÐÛë 
ØÝÔØÚÐâÞàÐ. ÂÕßÕàì ÜÞÖÝÞ ÞâÚÛîçØâì ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Þâ 
ÚÞÜÜãÝØÚÐâÞàÐ.

¿àØÜÕçÐÝØÕ. ²Þ ÒàÕÜï ×ÐàïÔÚØ ÚÞÜÜãÝØÚÐâÞàÞÜ ÜÞÖÝÞ ßÞÛì×ÞÒÐâìáï ÚÐÚ 
ÞÑëçÝÞ.

¸ÝâÕàäÕÙá ÚÞÜÜãÝØÚÐâÞàÐ
ÁÞÒÕâ. ¿àØ ×ÐÜÕÝÕ 

áâÐàÞÙ ÜÞÔÕÛØ 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia ÝÐ 
ÚÞÜÜãÝØÚÐâÞà Nokia 9210 
Communicator ßàÞçØâÐÙâÕ 
ÓÛÐÒã “¾ÑéÐï 
ØÝäÞàÜÐæØï” àãÚÞÒÞÔáâÒÐ 
ßÞ íÚáßÛãÐâÐæØØ.

ÀØá. 5

ÃßàÐÒÛïîéØÕ 
ÚÛÐÒØèØ

ºÛÐÒØèÐ áÞ 
áâàÕÛÚÐÜØºÛÐÒØèÐ ÜÕÝî

ºÛÐÒØÐâãàÐ
ºÛÐÒØèÐ áßàÐÒÚØ

ºÛÐÒØèØ 
ßàØÛÞÖÕÝØÙ

´ØáßÛÕÙ
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Þ ¾áÝÞÒÝëÕ íÛÕÜÕÝâë ØÝâÕàäÕÙáÐ ÚÞÜÜãÝØÚÐâÞàÐ, ÒÚÛîçÐï ÔØáßÛÕÙ, ßÞÚÐ×ÐÝë 
ÝÐ àØá. 5. ´ØáßÛÕÙ ÒÚÛîçÐÕâáï ßàØ ÞâÚàëÒÐÝØØ ÚàëèÚØ ÚÞÜÜãÝØÚÐâÞàÐ. ½Ð 
ÔØáßÛÕÕ ÒÞááâÐÝÐÒÛØÒÐÕâáï ßàØÛÞÖÕÝØÕ, ÚÞâÞàÞÕ ÑëÛÞ ÐÚâØÒÝÞ Ò ßÞáÛÕÔÝØÙ 
àÐ×.

¿àØ ×ÐÚàëÒÐÝØØ ÚàëèÚØ ÔØáßÛÕÙ ÚÞÜÜãÝØÚÐâÞàÐ ÒëÚÛîçÐÕâáï, ßàØ íâÞÜ ÒáÕ 
ÔÐÝÝëÕ áÞåàÐÝïîâáï.

¿àØÜÕçÐÝØÕ. ÁßÕæØÐÛìÝÞ áÞåàÐÝïâì ØÝäÞàÜÐæØî ÝÕ âàÕÑãÕâáï. ¿àØ 
ÝÐÖÐâØØ ÚÛÐÒØèØ Close (·ÐÚàëâì), ßÕàÕÚÛîçÕÝØØ Ò ÔàãÓÞÕ 
ßàØÛÞÖÕÝØÕ, Ð âÐÚÖÕ ßàØ ×ÐÚàëÒÐÝØØ ÚàëèÚØ ÚÞÜÜãÝØÚÐâÞà 
Nokia 9210 Communicator ÐÒâÞÜÐâØçÕáÚØ áÞåàÐÝïÕâ ÒáÕ 
ÔÐÝÝëÕ.

ÀÐÑÞâÐ á ßàØÛÞÖÕÝØïÜØ
´Ûï ×ÐßãáÚÐ ßàØÛÞÖÕÝØÙ áÛãÖÐâ áÞÞâÒÕâáâÒãîéØÕ ÚÛÐÒØèØ Ò ÒÕàåÝÕÙ çÐáâØ 
ÚÛÐÒØÐâãàë. ¿àÕÔãáÜÞâàÕÝë áÛÕÔãîéØÕ ßàØÛÞÖÕÝØï: Desk (ÀÐÑÞçØÙ áâÞÛ), 
Telephone (ÂÕÛÕäÞÝ), Messaging (ÁÞÞÑéÕÝØï), Internet (¸ÝâÕàÝÕâ), Contacts 
(ºÞÝâÐÚâë), Calendar (ºÐÛÕÝÔÐàì), Office (¾äØá) Ø Extras (´ÞßÞÛÝØâÕÛìÝëÕ 
äãÝÚæØØ). 

ÁÞÒÕâ. ´Ûï ÒëÑÞàÐ 
ÐÚâØÒÝÞÓÞ ßàØÛÞÖÕÝØï 
ÜÞÖÝÞ ØáßÞÛì×ÞÒÐâì 
“¼ÕÝî ×ÐÔÐÝØÙ”, 
àÐáßÞÛÞÖÕÝÝÞÕ á ÛÕÒÞÙ 
áâÞàÞÝë ßÞÛÞáë ÜÕÝî.

´Ûï ßÕàÕÚÛîçÕÝØï ÝÐ ÔàãÓÞÕ ßàØÛÞÖÕÝØÕ ÝÐÖÜØâÕ áÞÞâÒÕâáâÒãîéãî 
ÚÛÐÒØèã ßàØÛÞÖÕÝØï. ÍâÞ ÜÞÖÝÞ ÔÕÛÐâì ÔÐÖÕ ÒÞ ÒàÕÜï àÐ×ÓÞÒÞàÐ ßÞ 
âÕÛÕäÞÝã. ·ÐÚàëÒÐâì ÞÔÝÞ ßàØÛÞÖÕÝØÕ ßÕàÕÔ ×ÐßãáÚÞÜ ÔàãÓÞÓÞ ßàØÛÞÖÕÝØï 
ÝÕ âàÕÑãÕâáï. ²áÕ ÝÕÐÚâØÒÝëÕ ßàØÛÞÖÕÝØï ÞáâÐîâáï Ò äÞÝÞÒÞÜ áÞáâÞïÝØØ ÔÞ 
âÕå ßÞà, ßÞÚÐ ÞÝØ ÝÕ ÑãÔãâ ×ÐßãéÕÝë áÝÞÒÐ.
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ÀØá. 6

¿àØÜÕà. µáÛØ 
Ò àãÚÞÒÞÔáâÒÕ 
ßàÕÔÛÐÓÐÕâáï, ÝÐßàØÜÕà, 
ÝÐÖÐâì Open (¾âÚàëâì), 
íâÞ Þ×ÝÐçÐÕâ, çâÞ 
ÝÕÞÑåÞÔØÜÞ ÝÐÖÐâì 
ãßàÐÒÛïîéãî ÚÛÐÒØèã, 
àÐáßÞÛÞÖÕÝÝãî ÝÐßàÞâØÒ 
ÚÞÜÐÝÔë Open.

¾áÝÞÒÝëÕ íÛÕÜÕÝâë ÔØáßÛÕï ßÞÚÐ×ÐÝë ÝÐ àØá. 6. ºÞÜÐÝÔë ÒáÕÓÔÐ 
áÞÞâÒÕâáâÒãîâ çÕâëàÕÜ ÚÞÜÐÝÔÝëÜ ÚÛÐÒØèÐÜ. ² àãÚÞÒÞÔáâÒÐå ÚÞÜÐÝÔë 
ÒëÔÕÛÕÝë ÖØàÝëÜ èàØäâÞÜ, Ð íÛÕÜÕÝâë, ÚÞâÞàëÕ ÒëÒÞÔïâáï ÝÐ ÔØáßÛÕÙ, 
ÒëÔÕÛÕÝë ÚãàáØÒÞÜ.

¿ÞÛÞáÐ ßàÞÚàãâÚØ ãÚÐ×ëÒÐÕâ, çâÞ áßØáÞÚ áÞÔÕàÖØâ ÑÞÛìèÕ íÛÕÜÕÝâÞÒ, çÕÜ 
ßÞÜÕéÐÕâáï ÝÐ ÔØáßÛÕÕ. ´Ûï ßàÞÚàãâÚØ Ø×ÞÑàÐÖÕÝØï ÝÐ ÔØáßÛÕÕ áÛãÖØâ 
ÚÛÐÒØèÐ áÞ áâàÕÛÚÐÜØ, àÐáßÞÛÞÖÕÝÝÐï Ò ßàÐÒÞÜ ÝØÖÝÕÜ ãÓÛã ÚÛÐÒØÐâãàë.

µáÛØ Ò ÝØÖÝÕÙ çÐáâØ ÔØáßÛÕï ÞâÞÑàÐÖÐÕâáï ßÞÛÕ ßÞØáÚÐ, Ò íâÞ ßÞÛÕ ÜÞÖÝÞ 
á ÚÛÐÒØÐâãàë ÒÒÕáâØ âÕÚáâ ÔÛï ßÞØáÚÐ âàÕÑãÕÜÞÓÞ íÛÕÜÕÝâÐ.

µáÛØ ÝÐ ÔØáßÛÕÕ ÞâÞÑàÐÖÐÕâáï ÑÞÛÕÕ ÞÔÝÞÓÞ ÞÚÝÐ, ÒëÑàÐÝÝÞÕ ÞÚÝÞ ÒáÕÓÔÐ 
ÒëÔÕÛÕÝÞ.

ÍâÞâ íÛÕÜÕÝâ 
ÒëÑàÐÝ

¿àÐÒÞÕ ÞÚÝÞ; ÔÛï ÒëÔÕÛÕÝØï íâÞÓÞ 
ÞÚÝÐ ÝÐÖÜØâÕ ÚÛÐÒØèã Tab

»ÕÒÞÕ ÞÚÝÞ 
ÒëÔÕÛÕÝÞ

ÁÒÕÔÕÝØï ÞÑ 
íÛÕÜÕÝâÕ

ºÞÜÐÝÔë, ÚÞâÞàëÕ 
ÜÞÖÝÞ ÒëßÞÛÝØâì
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Þ ´Ûï ßÕàÕÜÕéÕÝØï ÜÕÖÔã ÒëÑàÐÝÝëÜØ ÞÚÝÐÜØ Ø ÒëÑàÐÝÝëÜØ íÛÕÜÕÝâÐÜØ 
áÛãÖØâ ÚÛÐÒØèÐ áÞ áâàÕÛÚÐÜØ.

´Ûï ÔÞáâãßÐ Ú ÚÞÜÐÝÔÐÜ ÜÕÝî ÝÐÖÜØâÕ ÚÛÐÒØèã Menu.

½ÐáâàÞÙÚÐ ÚÞÝäØÓãàÐæØØ
´Ûï ÔÞáâãßÐ Ú áÕâØ ¸ÝâÕàÝÕâ, ãáÛãÓÐÜ WAP Ø ãÔÐÛÕÝÝÞÜã ßÞçâÞÒÞÜã ïéØÚã 
ÝÕÞÑåÞÔØÜÞ ÝÐáâàÞØâì áÞÞâÒÕâáâÒãîéØÕ ßÐàÐÜÕâàë. 

¿àØÜÕçÐÝØÕ. ´Ûï ãßàÞéÕÝØï ßàÞæÕÔãàë ÝÐáâàÞÙÚØ Ú ÚÞÜÜãÝØÚÐâÞàã 
ßàØÛÐÓÐÕâáï ÃáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì (Settings checklist). 
² íâÞÜ ÔÞÚãÜÕÝâÕ ãÚÐ×ÐÝÞ, ÚÐÚÐï ØÝäÞàÜÐæØï âàÕÑãÕâáï, ÓÔÕ 
ÕÕ Ò×ïâì Ø ÚÐÚ ÒÒÕáâØ Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ. ¾Ñï×ÐâÕÛìÝÞ 
×ÐßØèØâÕ íâã ßÞÛÕ×Ýãî áßàÐÒÞçÝãî ØÝäÞàÜÐæØî Ò 
ãáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì: ÒßÞáÛÕÔáâÒØØ íâÐ ØÝäÞàÜÐæØï 
ßÞâàÕÑãÕâáï ßàØ ×ÐßàÞáÕ ÝÕÞÑåÞÔØÜëå ÔÐÝÝëå Þâ 
ßÞáâÐÒéØÚÐ ãáÛãÓ.

1 ½ÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï Extras ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.
2 Á ßÞÜÞéìî ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÒëÑÕàØâÕ ×ÝÐçÞÚ Internet startup 

(¿ÐàÐÜÕâàë ¸ÝâÕàÝÕâ) Ø ÝÐÖÜØâÕ Open (¾âÚàëâì). ½Ð ÔØáßÛÕÕ ßÞïÒïâáï 
âàØ ×ÝÐçÚÐ: Internet access (´Þáâãß Ú ̧ ÝâÕàÝÕâ), WAP access (´Þáâãß Ú ãáÛãÓÐÜ 
WAP) Ø Mail account (´Þáâãß Ú ßÞçâÞÒÞÜã ïéØÚã).

ÁÞÒÕâ. ¿ÞÔàÞÑÝÐï 
ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ 
Ò ÓÛÐÒÕ “´ÞßÞÛÝØâÕÛìÝëÕ 
ßàØÛÞÖÕÝØï” àãÚÞÒÞÔáâÒÐ 
ßÞ íÚáßÛãÐâÐæØØ.

3 ²ëÑÕàØâÕ ×ÝÐçÞÚ Internet access Ø ÝÐÖÜØâÕ Open. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ.
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ÀØá. 7

ÁÞÒÕâ. ´Ûï ßÞÛãçÕÝØï 
áßàÐÒÞçÝÞÙ ØÝäÞàÜÐæØØ Þ 
ÔÐÝÝëå, ÚÞâÞàëÕ 
ÝÕÞÑåÞÔØÜÞ ÒÒÕáâØ Ò íâÞÜ 
Ø áÛÕÔãîéØå ÔØÐÛÞÓÐå, 
ÝÐÖÜØâÕ ÚÛÐÒØèã , 
çâÞÑë Òë×ÒÐâì áßàÐÒÚã; 
áÜ. âÐÚÖÕ àãÚÞÒÞÔáâÒÞ ßÞ 
íÚáßÛãÐâÐæØØ.

4 ²ÒÕÔØâÕ ÝÕÞÑåÞÔØÜëÕ ÔÐÝÝëÕ Ø ÝÐÖÜØâÕ Advanced settings 
(´ÞßÞÛÝØâÕÛìÝëÕ ßÐàÐÜÕâàë). ¾âÚàÞÕâáï çÕâëàÕåáâàÐÝØçÝÞÕ ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ.

ÀØá. 8

²ÒÕÔØâÕ ÔÐÝÝëÕ ÝÐ ÚÐÖÔÞÙ áâàÐÝØæÕ. 
ÁÞÒÕâ. ´Ûï ßÕàÕåÞÔÐ Þâ 

ÞÔÝÞÙ áâàÐÝØæÕ Ú ÔàãÓÞÙ 
ÝÐÖÜØâÕ ÚÛÐÒØèã Menu.

5 ½Ð áâàÐÝØæÕ Other (¿àÞçÕÕ) ÝÐÖÜØâÕ Address options (¿ÐàÐÜÕâàë ÐÔàÕáÐ). 
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.



©2001 Nokia Mobile Phones. All rights reserved. 

12
ºà

Ðâ
ÚÞ

Õ 
àã

ÚÞ
ÒÞ

Ôá
âÒ

Þ

ÀØá. 9

² íâÞÜ ÞÚÝÕ ÞßàÕÔÕÛïîâáï ÐÔàÕáÐ IP Ø DNS.
´Ûï ÒÞ×ÒàÐâÐ Ò ÞÚÝÞ á âàÕÜï ×ÝÐçÚÐÜØ ÝÐÖÜØâÕ Done (³ÞâÞÒÞ).

ÁÞÒÕâ. ¿ÞÔàÞÑÝÐï 
ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ 
Ò ÓÛÐÒÕ “¸ÝâÕàÝÕâ” 
àãÚÞÒÞÔáâÒÐ ßÞ 
íÚáßÛãÐâÐæØØ.

6 ²ëÑÕàØâÕ ×ÝÐçÞÚ WAP access Ø ÝÐÖÜØâÕ Open. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.

ÀØá. 10

²ÒÕÔØâÕ ÔÐÝÝëÕ ÝÐ ÚÐÖÔÞÙ áâàÐÝØæÕ Ø ÝÐÖÜØâÕ Close ÔÛï ÒÞ×ÒàÐâÐ Ò ÞÚÝÞ 
á âàÕÜï ×ÝÐçÚÐÜØ.

ÁÞÒÕâ. ¿ÞÔàÞÑÝÐï 
ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ 
Ò ÓÛÐÒÕ “ÁÞÞÑéÕÝØï” 
àãÚÞÒÞÔáâÒÐ ßÞ 
íÚáßÛãÐâÐæØØ.

7 ²ëÑÕàØâÕ Mail account Ø ÝÐÖÜØâÕ Open. ¾âÚàÞÕâáï çÕâëàÕåáâàÐÝØçÝÞÕ 
ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.
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ÀØá. 11

²ÒÕÔØâÕ ÔÐÝÝëÕ ÝÐ ÚÐÖÔÞÙ áâàÐÝØæÕ Ø ÝÐÖÜØâÕ Done ÔÛï ÒÞ×ÒàÐâÐ Ò ÞÚÝÞ 
á âàÕÜï ×ÝÐçÚÐÜØ.

¿ÞÔÚÛîçÕÝØÕ Ú ¿º
¿ÞÔÚÛîçÕÝØÕ ÚÞÜÜãÝØÚÐâÞàÐ Ú áÞÒÜÕáâØÜÞÜã ÝÐáâÞÛìÝÞÜã ØÛØ 
ßÞàâÐâØÒÝÞÜã ¿º ÞáãéÕáâÒÛïÕâáï á ßÞÜÞéìî ßàÞÓàÐÜÜë PC Suite ÔÛï 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210, ÚÞâÞàÐï ÝÐåÞÔØâáï ÝÐ ÚÞÜßÐÚâ-ÔØáÚÕ Ø× 
ÚÞÜßÛÕÚâÐ ßÞáâÐÒÚØ ÚÞÜÜãÝØÚÐâÞàÐ. ½Ð ÚÞÜßÐÚâ-ÔØáÚÕ Ò àÐ×ÔÕÛÕ Using Nokia 
9210 Communicator (¸áßÞÛì×ÞÒÐÝØÕ ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210) âÐÚÖÕ 
ÝÐåÞÔØâáï ÀãÚÞÒÞÔáâÒÞ ßÞÛì×ÞÒÐâÕÛï ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï PC Suite.

¿àÞÓàÐÜÜÐ PC Suite for Nokia 9210 Communicator ßàÕÔÝÐ×ÝÐçÕÝÐ ÔÛï àÐÑÞâë 
Ò Windows 95/98, 2000 Ø NT. ¾ÝÐ ØÝâÕÓàØàãÕâ äÐÙÛÞÒãî áØáâÕÜã 
ÚÞÜÜãÝØÚÐâÞàÐ Ò äÐÙÛÞÒãî áØáâÕÜã ÚÞÜßìîâÕàÐ, ßÞ×ÒÞÛïï ÞßÕàÐâØÒÝÞ 
ßÕàÕÜÕéÐâì, ÚÞßØàÞÒÐâì, ßÕàÕØÜÕÝÞÒëÒÐâì Ø ãÔÐÛïâì äÐÙÛë Ø ßÐßÚØ 
ÚÞÜÜãÝØÚÐâÞàÐ Ø ¿º.

Á ßÞÜÞéìî ßàÞÓàÐÜÜë PC Suite ÜÞÖÝÞ áØÝåàÞÝØ×ØàÞÒÐâì ÔÐÝÝëÕ 
ßàØÛÞÖÕÝØÙ (ÝÐßàØÜÕà, ÚÞÝâÐÚâÞÒ Ø íÛÕÚâàÞÝÝÞÙ ßÞçâë) ÜÕÖÔã 
ÚÞÜÜãÝØÚÐâÞàÞÜ Ø ¿º, Ð âÐÚÖÕ áÞ×ÔÐÒÐâì àÕ×ÕàÒÝëÕ ÚÞßØØ ÔÐÝÝëå ÝÐ ÔØáÚÕ 
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Þ ¿º. ¼ÞÖÝÞ âÐÚÖÕ ÐÒâÞÜÐâØ×ØàÞÒÐâì áØÝåàÞÝØ×ÐæØî Ø àÕ×ÕàÒÝÞÕ ÚÞßØàÞÒÐÝØÕ, 
âÞÓÔÐ íâØ ÞßÕàÐæØØ ÑãÔãâ ÒëßÞÛÝïâìáï Ò ×ÐÔÐÝÝÞÕ ÒàÕÜï ØÛØ ßàØ 
ßÞÔÚÛîçÕÝØØ ÚÞÜÜãÝØÚÐâÞàÐ Ú ¿º.

¿àÞÓàÐÜÜã PC Suite ÜÞÖÝÞ ×ÐßãáâØâì Ø ÑÕ× ßÞÔÚÛîçÕÝØï ÚÞÜÜãÝØÚÐâÞàÐ 
Ú ÚÞÜßìîâÕàã (ÐÒâÞÝÞÜÝëÙ àÕÖØÜ). ¿àØ ÞçÕàÕÔÝÞÜ áÞÕÔØÝÕÝØØ ÔÒãå 
ãáâàÞÙáâÒ Ø×ÜÕÝÕÝØï ÔÐÝÝëå ÑãÔãâ ßÕàÕÝÕáÕÝë Ø× ¿º Ò ÚÞÜÜãÝØÚÐâÞà Ø 
ÞÑàÐâÝÞ.

¿Àµ´Ã¿Àµ¶´µ½¸µ. ¾áâÕàÕÓÐÙâÕáì ÒØàãáÞÒ. ÃáâÐÝÐÒÛØÒÐÙâÕ ÝÐ 
ÚÞÜÜãÝØÚÐâÞà âÞÛìÚÞ ßàÞÓàÐÜÜÝÞÕ ÞÑÕáßÕçÕÝØÕ, 
ÚÞâÞàÞÕ ßÞÛãçÕÝÞ Ø× ØáâÞçÝØÚÞÒ, ÓÐàÐÝâØàãîéØå 
ÞâáãâáâÒØÕ ÒØàãáÞÒ. ÁÜ. àÐ×ÔÕÛ “ÃßàÐÒÛÕÝØÕ 
áÕàâØäØÚÐâÐÜØ” àãÚÞÒÞÔáâÒÐ ßÞ íÚáßÛãÐâÐæØØ.

¿ÞÔÚÛîçÕÝØÕ ÚÞÜÜãÝØÚÐâÞàÐ Ú ¿º
1 ¿àØ ßÞÔÚÛîçÕÝØØ ÚÐÑÕÛï RS-232 ÑÞÛìèØÙ àÐ×êÕÜ ÒÚÛîçÐÕâáï 

Ò ßÞáÛÕÔÞÒÐâÕÛìÝëÙ ßÞàâ (COM) ÚÞÜßìîâÕàÐ, Ð ÜÕÝìèØÙ àÐ×êÕÜ — 
Ú àÐ×êÕÜã Ò ÝØÖÝÕÙ çÐáâØ ÚÞÜÜãÝØÚÐâÞàÐ. 

2 ¿àØ ØáßÞÛì×ÞÒÐÝØØ ØÝäàÐÚàÐáÝÞÓÞ ßÞàâÐ ØÛØ ßÞáÛÕÔÞÒÐâÕÛìÝÞÓÞ ßÞàâÐ, 
ÞâÛØçÝÞÓÞ Þâ COM1, ÔÒÐÖÔë éÕÛÚÝØâÕ Üëèìî ÝÐ ×ÝÐçÚÕ áÞÕÔØÝÕÝØï PC 
Suite Ò ßÐÝÕÛØ ×ÐÔÐç Windows Ø ÒëÑÕàØâÕ âàÕÑãÕÜëÙ ßÞàâ.

3 ¾âÚàÞÙâÕ ÚÞÜÜãÝØÚÐâÞà.
4 ¿àØ ØáßÞÛì×ÞÒÐÝØØ ØÝäàÐÚàÐáÝÞÓÞ áÞÕÔØÝÕÝØï ãÑÕÔØâÕáì Ò âÞÜ, çâÞ ¸º-

ßÞàâ ÚÞÜÜãÝØÚÐâÞàÐ ÝÐßàÐÒÛÕÝ Ò áâÞàÞÝã ¸º-ßÞàâÐ ÚÞÜßìîâÕàÐ. ´Ûï 
ÒÚÛîçÕÝØï ¸º-ßÞàâÐ ÚÞÜÜãÝØÚÐâÞàÐ ÝÐÖÜØâÕ Chr +  (ÚÛÐÒØèÐ áÞ 
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Þ×ÝÐçÚÞÜ ØÝäàÐÚàÐáÝÞÓÞ áÞÕÔØÝÕÝØï). ´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï Þ 

àÐÑÞâÕ á ¸º-ßÞàâÞÜ ÚÞÜÜãÝØÚÐâÞàÐ ßàØÒÕÔÕÝÐ Ò àãÚÞÒÞÔáâÒÕ ßÞ 
íÚáßÛãÐâÐæØØ.

5 ·ÐßãáâØâÕ ÝÐ ¿º ßàÞÓàÐÜÜã PC Suite. 
ÂÕßÕàì ßàÞÓàÐÜÜÐ PC Suite ÐÒâÞÜÐâØçÕáÚØ ãáâÐÝÞÒØâ áÞÕÔØÝÕÝØÕ 
á ÚÞÜÜãÝØÚÐâÞàÞÜ.

¿àØÛÞÖÕÝØÕ Desk
¿àØÛÞÖÕÝØÕ Desk (ÀÐÑÞçØÙ áâÞÛ) ßàÕÔÝÐ×ÝÐçÕÝÞ ÔÛï ãßàÐÒÛÕÝØï Ø 
ØáßÞÛì×ÞÒÐÝØï àÐ×ÛØçÝëå ááëÛÞÚ ÝÐ ÔàãÓØÕ ßàØÛÞÖÕÝØï Ø ßàÞÓàÐÜÜÝÞÕ 
ÞÑÕáßÕçÕÝØÕ ÔàãÓØå Ø×ÓÞâÞÒØâÕÛÕÙ. ÁáëÛÚØ áÞ×ÔÐîâáï Ò áÞÞâÒÕâáâÒãîéØå 
ßàØÛÞÖÕÝØïå.

´Ûï áÞ×ÔÐÝØï ááëÛÚØ
1 ¾âÚàÞÙâÕ ÞÑêÕÚâ Ò áÞÞâÒÕâáâÒãîéÕÜ ßàØÛÞÖÕÝØØ. 
2 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ Add to Desk (´ÞÑÐÒØâì ÝÐ àÐÑÞçØÙ 

áâÞÛ).

´Ûï ÒÒÞÔÐ ×ÐÜÕâÞÚ
1 ½ÐÖÜØâÕ Write note (½ÐßØáÐâì ×ÐÜÕâÚã). ¾âÚàÞÕâáï ßàÞáâÞÙ âÕÚáâÞÒëÙ 

àÕÔÐÚâÞà.
2 ²ÒÕÔØâÕ ×ÐÜÕâÚã.
3 ½ÐÖÜØâÕ Close (·ÐÚàëâì), çâÞÑë áÞåàÐÝØâì ÔÞÚãÜÕÝâ. ¿ÞáÛÕ íâÞÓÞ ×ÐÜÕâÚÐ 

ßÞïÒØâáï ÝÐ ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Desk.
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Þ ¿àØÛÞÖÕÝØÕ Telephone
¿àØÛÞÖÕÝØÕ Telephone (ÂÕÛÕäÞÝ) ØáßÞÛì×ãÕâáï ÔÛï ßÞáëÛÚØ Ø ßàØÕÜÐ 
ÓÞÛÞáÞÒëå Òë×ÞÒÞÒ, Ð âÐÚÖÕ ÔÛï ÝÐáâàÞÙÚØ ßÐàÐÜÕâàÞÒ âÕÛÕäÞÝÐ. ´Ûï 
×ÐßãáÚÐ ßàØÛÞÖÕÝØï Telephone ÞâÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ Ø ÝÐÖÜØâÕ 
ÚÛÐÒØèã ßàØÛÞÖÕÝØï Tel ÝÐ ÚÛÐÒØÐâãàÕ. ¼ÝÞÓØÕ Ø× ÞßÕàÐæØÙ, ÒëßÞÛÝïÕÜëå Ò 
ßàØÛÞÖÕÝØØ Telephone, âÐÚÖÕ ÔÞáâãßÝë á âÕÛÕäÞÝÐ (ÝÐ ÛØæÕÒÞÙ áâÞàÞÝÕ 
ÚàëèÚØ ÚÞÜÜãÝØÚÐâÞàÐ).

´Ûï ßÞáëÛÚØ âÕÛÕäÞÝÝëå Òë×ÞÒÞÒ ÝÕÞÑåÞÔØÜÞ áÛÕÔãîéÕÕ:

• âÕÛÕäÞÝ ÒÚÛîçÕÝ;
• Ò ÚÞÜÜãÝØÚÐâÞà ãáâÐÝÞÒÛÕÝÐ ÔÕÙáâÒãîéÐï SIM-ÚÐàâÐ;
• âÕÛÕäÞÝ ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ.

¿ÞáëÛÚÐ Òë×ÞÒÐ
´Ûï ßÞáëÛÚØ Òë×ÞÒÐ ÜÞÖÝÞ ÒÞáßÞÛì×ÞÒÐâìáï ÞÔÝØÜ Ø× ÔÒãå áßÞáÞÑÞÒ:

• ²ëÑÕàØâÕ ÚÞÝâÐÚâ Ø× ÚÐâÐÛÞÓÐ Telephone Ø ÝÐÖÜØâÕ Call (²ë×ÞÒ). µáÛØ 
ÚÞÝâÐÚâ áÞÔÕàÖØâ âÞÛìÚÞ ÞÔØÝ âÕÛÕäÞÝÝëÙ ÝÞÜÕà, Òë×ÞÒ ÞáãéÕáâÒÛïÕâáï 
áàÐ×ã.
µáÛØ ÚÞÝâÐÚâ áÞÔÕàÖØâ ÝÕáÚÞÛìÚÞ âÕÛÕäÞÝÝëå ÝÞÜÕàÞÒ, ÞâÚàëÒÐÕâáï 
áßØáÞÚ ÝÞÜÕàÞÒ; ÒëÑÕàØâÕ ÝÞÜÕà Ø× áßØáÚÐ Ø ÝÐÖÜØâÕ Call.

• ²ÒÕÔØâÕ âÕÛÕäÞÝÝëÙ ÝÞÜÕà Ò ßÞÛÕ ßÞØáÚÐ Ò ÝØÖÝÕÙ çÐáâØ ÓÛÐÒÝÞÓÞ íÚàÐÝÐ 
Ø ÝÐÖÜØâÕ Call.
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¿àØ ßÞáâãßÛÕÝØØ Òë×ÞÒÐ ÝÐ ÔØáßÛÕÕ ßÞïÒÛïÕâáï áÞÞÑéÕÝØÕ. ¼ÞÖÕâ âÐÚÖÕ 
ßÞÔÐÒÐâìáï ×ÒãÚÞÒÞÙ áØÓÝÐÛ Òë×ÞÒÐ. ´Ûï ÞâÒÕâÐ ÝÐ Òë×ÞÒ ÝÐÖÜØâÕ Answer 
(¾âÒÕâØâì); ÕáÛØ ÞâÒÕçÐâì ÝÐ Òë×ÞÒ ÝÕ âàÕÑãÕâáï, ÝÐÖÜØâÕ Reject (¾âÚÛÞÝØâì).

¿àÞäØÛì ¿ÞÛÕâ

¿àÞäØÛì "¿ÞÛÕâ" (Flight) ßÞ×ÒÞÛïÕâ ßàÕÔÞâÒàÐâØâì áÛãçÐÙÝÞÕ ÒÚÛîçÕÝØÕ 
âÕÛÕäÞÝÐ Ò áÐÜÞÛÕâÕ. ´Ûï ÒëÑÞàÐ ßàÞäØÛï "¿ÞÛÕâ":

1 ½Ð ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Telephone ÝÐÖÜØâÕ ÚÛÐÒØèã Menu, 
ßàÞÚàãâØâÕ ßÞÛÞáã ÜÕÝî ÔÞ ×ÝÐçÚÐ Profiles  (¿àÞäØÛØ), ×ÐâÕÜ ÒëÔÕÛØâÕ 
ßãÝÚâ Flight.

2 ½ÐÖÜØâÕ Select (²ëÑàÐâì).

¿àØ ÒëÑàÐÝÝÞÜ ßàÞäØÛÕ "¿ÞÛÕâ" ÒÞ×ÜÞÖÝÞ ÒëßÞÛÝÕÝØÕ âÕå ×ÐÔÐÝØÙ, 
ÚÞâÞàëÕ ÝÕ âàÕÑãîâ ßÞÔÚÛîçÕÝØï Ú áÞâÞÒÞÙ áÕâØ. ½ÐßàØÜÕà, ÜÞÖÝÞ çØâÐâì 
ßÞÛãçÕÝÝëÕ àÐÝÕÕ ßØáìÜÐ, ßØáÐâì ßØáìÜÐ, ×ÐÜÕâÚØ, ÚÞàÞâÚØÕ áÞÞÑéÕÝØï, 
äÐÚáØÜØÛìÝëÕ áÞÞÑéÕÝØï ØÛØ àÕÔÐÚâØàÞÒÐâì ÚÐÛÕÝÔÐàì. ¿ÞÚØÝãÒ áÐÜÞÛÕâ, 
ÝÐÖÜØâÕ Exit profile (²ëÙâØ Ø× ßàÞäØÛï) Ò ßàØÛÞÖÕÝØØ Telephone, çâÞÑë 
ÒëÚÛîçØâì ßàÞäØÛì "¿ÞÛÕâ". ·ÐâÕÜ ÜÞÖÝÞ ÒÚÛîçØâì âÕÛÕäÞÝ ÚÛÐÒØèÕÙ , 
ßÞáÛÕ çÕÓÞ ÚÞàÞâÚØÕ áÞÞÑéÕÝØï, äÐÚáØÜØÛìÝëÕ áÞÞÑéÕÝØï Ø ßÞçâÐ ÑãÔãâ 
ÞâßàÐÒÛÕÝë ÐÒâÞÜÐâØçÕáÚØ.

ºÞÓÔÐ ÚÞÜÜãÝØÚÐâÞà ÝÐåÞÔØâáï Ò àÕÖØÜÕ “¿ÞÛÕâ”, Òë×ÞÒ áÛãÖÑë íÚáâàÕÝÝÞÙ 
ßÞÜÞéØ ÞáãéÕáâÒÛïÕâáï âÞÛìÚÞ á ßÞÜÞéìî âÕÛÕäÞÝÐ (ßàØ ×ÐÚàëâÞÙ ÚàëèÚÕ 
ÚÞÜÜãÝØÚÐâÞàÐ):

1 ½ÐÖÜØâÕ . ½Ð ÔØáßÛÕÕ âÕÛÕäÞÝÐ ßÞïÒØâáï áÞÞÑéÕÝØÕ Flight profile is 
active. (¿àÞäØÛì “¿ÞÛÕâ” ÐÚâØÒÕÝ).



©2001 Nokia Mobile Phones. All rights reserved. 

18
ºà

Ðâ
ÚÞ

Õ 
àã

ÚÞ
ÒÞ

Ôá
âÒ

Þ 2 ¿àØ ÒëÒÕÔÕÝÝÞÜ ÝÐ ÔØáßÛÕÙ áÞÞÑéÕÝØØ (Ò âÕçÕÝØÕ ßàØÜÕàÝÞ ßïâØ áÕÚãÝÔ) 
ÜÞÖÝÞ ÝÐÑàÐâì ÝÞÜÕà áÛãÖÑë íÚáâàÕÝÝÞÙ ßÞÜÞéØ, ×ÐßàÞÓàÐÜÜØàÞÒÐÝÝëÙ 
Ò ßÐÜïâØ ÚÞÜÜãÝØÚÐâÞàÐ, ÝÐßàØÜÕà, 112.

3 ½ÐÖÜØâÕ .

²°¶½¾µ ·°¼µÇ°½¸µ. ¸áßÞÛì×ÞÒÐÝØÕ àÐÔØÞâÕÛÕäÞÝÐ Ò áÐÜÞÛÕâÕ 
×ÐßàÕéÕÝÞ. µáÛØ ßÕàáÞÝÐÛ áÐÜÞÛÕâÐ àÐ×àÕèÐÕâ 
ØáßÞÛì×ÞÒÐÝØÕ ØÝâÕàäÕÙáÐ ÚÞÜÜãÝØÚÐâÞàÐ, ½µ¾±Å¾´¸¼¾ 
ãáâÐÝÞÒØâì ßàÞäØÛì “¿ÞÛÕâ”. ÍâÞâ ßàÞäØÛì ßÞ×ÒÞÛïÕâ 
ØáßÞÛì×ÞÒÐâì ØÝâÕàäÕÙá ÚÞÜÜãÝØÚÐâÞàÐ Ø ÑÛÞÚØàãÕâ 
ÒÚÛîçÕÝØÕ âÕÛÕäÞÝÐ. ¾ÑàÐâØâÕ ÒÝØÜÐÝØÕ ÝÐ âÞ, çâÞ ÒÞ ÒáÕå 
ÚÞÜÜãÝØÚÐæØÞÝÝëå ßàØÛÞÖÕÝØïå ØáßÞÛì×ãÕâáï ØÝâÕàäÕÙá 
âÕÛÕäÞÝÐ.

¿àØÛÞÖÕÝØï Messaging
³àãßßÐ Messaging áÞÔÕàÖØâ ßàØÛÞÖÕÝØï Fax (ÂÕÛÕäÐÚá), Mail (¿ÞçâÐ) Ø SMS 
(ºÞàÞâÚØÕ áÞÞÑéÕÝØï). ´Ûï ×ÐßãáÚÐ ßàØÛÞÖÕÝØï Messaging ÝÐÖÜØâÕ ÚÛÐÒØèã 
ßàØÛÞÖÕÝØï Messaging ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.

´Ûï ßÕàÕÔÐçØ Ø ßàØÕÜÐ äÐÚáÞÒ, íÛÕÚâàÞÝÝÞÙ ßÞçâë Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ 
ÔÞÛÖÝë Ñëâì ÒëßÞÛÝÕÝë áÛÕÔãîéØÕ ãáÛÞÒØï:

• âÕÛÕäÞÝ ÒÚÛîçÕÝ;
• ØáßÞÛì×ãÕÜÐï áÞâÞÒÐï áÕâì ßàÕÔÞáâÐÒÛïÕâ ãáÛãÓØ ßÕàÕÔÐçØ äÐÚáÞÒ, 

ÔÐÝÝëå Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ;
• ãáÛãÓØ ßÕàÕÔÐçØ äÐÚáÞÒ, ÔÐÝÝëå Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ ßÞÔÔÕàÖØÒÐîâáï 

SIM-ÚÐàâÞÙ;
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Þ• ßÞáâÐÒéØÚ ãáÛãÓ ̧ ÝâÕàÝÕâ ßàÕÔÞáâÐÒØÛ ÔÐÝÝëÕ ßãÝÚâÐ ÔÞáâãßÐ Ò ̧ ÝâÕàÝÕâ 

(IAP), Ð Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ ÒÒÕÔÕÝë ßÐàÐÜÕâàë ÔÞáâãßÐ Ú ̧ ÝâÕàÝÕâ Ø 
ßÞçâÞÒÞÜã áÕàÒÕàã;

• ÝÞÜÕà æÕÝâàÐ ßÕàÕÔÐçØ ÚÞàÞâÚØå áÞÞÑéÕÝØÙ ÒÒÕÔÕÝ Ò ßàØÛÞÖÕÝØÕ SMS.

´ÞßÞÛÝØâÕÛìÝãî ØÝäÞàÜÐæØî ÜÞÖÝÞ ßÞÛãçØâì ã ßÞáâÐÒéØÚÐ ãáÛãÓ áÞâÞÒÞÙ 
áÕâØ.

¿àØÜÕçÐÝØÕ. ¿ÞçâÞÒÐï áØáâÕÜÐ ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210 Communicator 
áÞÒÜÕáâØÜÐ áÞ áâÐÝÔÐàâÐÜØ ¸ÝâÕàÝÕâ SMTP, IMAP4 Ø POP3.

ÁÞ×ÔÐÝØÕ Ø ßÕàÕÔÐçÐ äÐÚáÞÒ, íÛÕÚâàÞÝÝÞÙ 
ßÞçâë Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ
´Ûï áÞ×ÔÐÝØï, àÕÔÐÚâØàÞÒÐÝØï Ø ßÕàÕÔÐçØ äÐÚáÞÒ, áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ 
ßÞçâë Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ ßàÕÔÝÐ×ÝÐçÕÝë áÞÞâÒÕâáâÒãîéØÕ àÕÔÐÚâÞàë, 
ÔÛï ×ÐßãáÚÐ ÚÞâÞàëå ßàÕÔãáÜÞâàÕÝÞ âàØ áßÞáÞÑÐ: 

• ²ÒÕÔØâÕ Ø ÞâäÞàÜÐâØàãÙâÕ âÕÚáâ Ò ÛîÑÞÜ Ø× ßàØÛÞÖÕÝØÙ ÚÞÜÜãÝØÚÐâÞàÐ, 
ÚÞâÞàÞÕ ßÞ×ÒÞÛïÕâ àÕÔÐÚâØàÞÒÐâì âÕÚáâ. ´Ûï ßÕàÕÔÐçØ âÕÚáâÐ ÝÐÖÜØâÕ 
ÚÛÐÒØèã Menu, ÒëÑÕàØâÕ File > Send, ×ÐâÕÜ ÒëÑÕàØâÕ Ò ßÞÔÜÕÝî ÞÔØÝ Ø× 
àÕÖØÜÞÒ ßÕàÕÔÐçØ.

• ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Messaging ÒëÑÕàØâÕ ÞÔÝã Ø× ÚÞÜÐÝÔ: Write 
fax (ÁÞ×ÔÐâì äÐÚá), Write mail (ÁÞ×ÔÐâì ßØáìÜÞ) ØÛØ Write short message 
(ÁÞ×ÔÐâì ÚÞàÞâÚÞÕ áÞÞÑéÕÝØÕ).

• ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Messaging ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø 
ÒëÑÕàØâÕ Write > New message…. ·ÐâÕÜ ÒëÑÕàØâÕ âàÕÑãÕÜëÙ âØß 
áÞÞÑéÕÝØï.
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Þ ²ëÑÞà ÐÔàÕáÐâÞÒ

¿àØÜÕçÐÝØÕ. ÄÐÚá ÜÞÖÝÞ ÞâßàÐÒØâì âÞÛìÚÞ ßÞ ÞÔÝÞÜã ÐÔàÕáã.

¿àÕÔãáÜÞâàÕÝÞ ÔÒÐ áßÞáÞÑÐ ÒëÑÞàÐ ÐÔàÕáÐ ÝÐ×ÝÐçÕÝØï ÔÛï ßÕàÕÔÐçØ äÐÚáÐ, 
íÛÕÚâàÞÝÝÞÓÞ ßØáìÜÐ Ø ÚÞàÞâÚÞÓÞ áÞÞÑéÕÝØï:

1 ½ÐÖÜØâÕ Recipient (°ÔàÕáÐâ) Ò áÞÞâÒÕâáâÒãîéÕÜ àÕÔÐÚâÞàÕ áÞÞÑéÕÝØÙ. 
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ áÞ áßØáÚÞÜ ÚÞÝâÐÚâÞÒ.

2 ½ÐÙÔØâÕ ÚÞÝâÐÚâ ØÛØ ÚÞÝâÐÚâë Ò ÛÕÒÞÜ ÞÚÝÕ Ø ÝÐÖÜØâÕ Select (²ëÑàÐâì).
3 ½ÐÖÜØâÕ Done (³ÞâÞÒÞ).

¼ÞÖÝÞ âÐÚÖÕ ÒÒÕáâØ ØÜï ÐÔàÕáÐâÐ Ò ×ÐÓÞÛÞÒÚÕ äÐÚáÐ, íÛÕÚâàÞÝÝÞÓÞ ßØáìÜÐ 
ØÛØ ÚÞàÞâÚÞÓÞ áÞÞÑéÕÝØï Ø áÒÕàØâì íâÞ ØÜï á ÑÐ×ÞÙ ÔÐÝÝëå ÚÞÝâÐÚâÞÒ.

¿àØÕÜ Ø çâÕÝØÕ äÐÚáÞÒ Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ
¿àØÕÜ äÐÚáÞÒ ÞáãéÕáâÒÛïÕâáï ÐÒâÞÜÐâØçÕáÚØ ßàØ ãáÛÞÒØØ, çâÞ âÐÚÐï ãáÛãÓÐ 
ÔÞáâãßÝÐ, Ð âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ. 
ºÞàÞâÚØÕ áÞÞÑéÕÝØï ßàØÝØÜÐîâáï ÐÒâÞÜÐâØçÕáÚØ, ÕáÛØ âÕÛÕäÞÝ ÒÚÛîçÕÝ.

¿àÕÔãáÜÞâàÕÝÞ ÔÒÐ áßÞáÞÑÐ çâÕÝØï ßàØÝïâëå äÐÚáÞÒ Ø ÚÞàÞâÚØå áÞÞÑéÕÝØÙ:

• ¿àØ ßÞïÒÛÕÝØØ ÝÐ ÔØáßÛÕÕ áÞÞÑéÕÝØï (ØÛØ ßÞáÛÕ ×ÒãÚÞÒÞÓÞ áØÓÝÐÛÐ Þ 
ßàØÕÜÕ áÞÞÑéÕÝØï) ÝÐÖÜØâÕ Open (¾âÚàëâì). ·ÒãÚÞÒÞÙ áØÓÝÐÛ ßÞÔÐÕâáï 
âÞÛìÚÞ Ò ÞßàÕÔÕÛÕÝÝëå áÛãçÐïå.

• ¾âÚàÞÙâÕ ßàØÛÞÖÕÝØÕ Messaging. ²ëÑÕàØâÕ ßàØÝïâÞÕ áÞÞÑéÕÝØÕ Ò ßÐßÚÕ 
Inbox Ø ÝÐÖÜØâÕ Open. ÄÐÚá ØÛØ ÚÞàÞâÚÞÕ áÞÞÑéÕÝØÕ ÑãÔÕâ ÞâÚàëâÞ Ò 
áÞÞâÒÕâáâÒãîéÕÜ ßàØÛÞÖÕÝØØ.
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Þ¿àØÕÜ Ø çâÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë

²åÞÔïéÐï ßÞçâÐ ÝÕ ßÞáâãßÐÕâ Ò ÚÞÜÜãÝØÚÐâÞà ÐÒâÞÜÐâØçÕáÚØ, Ð åàÐÝØâáï Ò 
ãÔÐÛÕÝÝÞÜ ßÞçâÞÒÞÜ ïéØÚÕ. ´Ûï çâÕÝØï ßÞçâë ÝÕÞÑåÞÔØÜÞ áÝÐçÐÛÐ 
ãáâÐÝÞÒØâì áÞÕÔØÝÕÝØÕ á ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ Ø ÒëÑàÐâì 
áÞÞÑéÕÝØï, ÚÞâÞàëÕ âàÕÑãÕâáï ×ÐÓàã×Øâì Ò ÚÞÜÜãÝØÚÐâÞà. ÁÞÕÔØÝÕÝØÕ á 
ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ ÞáãéÕáâÒÛïÕâáï ßÞáàÕÔáâÒÞÜ Òë×ÞÒÐ Ò àÕÖØÜÕ 
ßÕàÕÔÐçØ ÔÐÝÝëå.

ÁÞÕÔØÝÕÝØÕ á ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ

1 ²ëÑÕàØâÕ ãÔÐÛÕÝÝëÙ ßÞçâÞÒëÙ ïéØÚ Ò ÛÕÒÞÜ ÞÚÝÕ ÓÛÐÒÝÞÓÞ íÚàÐÝÐ 
ßàØÛÞÖÕÝØï Messaging.

2 ²ëÑÕàØâÕ ßàÐÒÞÕ ÞÚÝÞ Ø ÝÐÖÜØâÕ Retrieve mail (·ÐÓàã×Øâì ßÞçâã). 
3 ¿ÞáÛÕ ãáâÐÝÞÒÛÕÝØï áÞÕÔØÝÕÝØï á ãÔÐÛÕÝÝëÜ ßÞçâÞÒëÜ ïéØÚÞÜ ÝÐÖÜØâÕ 

ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ Retrieve > New (½ÞÒëÕ), Selected (²ëÑàÐÝÝëÕ) 
ØÛØ All (²áÕ áÞÞÑéÕÝØï íÛÕÚâàÞÝÝÞÙ ßÞçâë).

4 ¿ÞáÛÕ ×ÐÒÕàèÕÝØï ×ÐÓàã×ÚØ ÒáÕå ×ÐßàÞèÕÝÝëå áÞÞÑéÕÝØÙ íÛÕÚâàÞÝÝÞÙ 
ßÞçâë ÝÐÖÜØâÕ Go offline (ÀÐ×ÞàÒÐâì áÞÕÔØÝÕÝØÕ).

5 ²ëÑÕàØâÕ áÞÞÑéÕÝØÕ íÛÕÚâàÞÝÝÞÙ ßÞçâë, ÚÞâÞàÞÕ âàÕÑãÕâáï ßàÞçØâÐâì, Ø 
ÝÐÖÜØâÕ Open (¾âÚàëâì).

¿àØÛÞÖÕÝØÕ Internet
´Ûï ßÞÛãçÕÝØï ÔÞáâãßÐ Ú áÕâØ ̧ ÝâÕàÝÕâ ÔÞÛÖÝë Ñëâì ÒëßÞÛÝÕÝë áÛÕÔãîéØÕ 
ãáÛÞÒØï:

• áÞâÞÒÐï áÕâì ßàÕÔÞáâÐÒÛïÕâ ãáÛãÓã ßÕàÕÔÐçØ ÔÐÝÝëå;
• ãáÛãÓÐ ßÕàÕÔÐçØ ÔÐÝÝëå ßÞÔÔÕàÖØÒÐÕâáï SIM-ÚÐàâÞÙ;
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Þ • ßÞáâÐÒéØÚ ãáÛãÓ ̧ ÝâÕàÝÕâ ßàÕÔÞáâÐÒØÛ ÔÐÝÝëÕ ßãÝÚâÐ ÔÞáâãßÐ Ò ̧ ÝâÕàÝÕâ 
(IAP) Ø

• Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ ÒÒÕÔÕÝë ßÐàÐÜÕâàë ÔÞáâãßÐ Ú ¸ÝâÕàÝÕâ. 
²ëßÞÛÝØâÕ ØÝáâàãÚæØØ, ßàØÒÕÔÕÝÝëÕ Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ. 
·ÐßØèØâÕ ×ÝÐçÕÝØï ßÐàÐÜÕâàÞÒ Ò ÃáâÐÝÞÒÞçÝëÙ ßÕàÕçÕÝì (Settings 
checklist), ßàØÛÐÓÐÕÜëÙ Ú ÚÞÜÜãÝØÚÐâÞàã.

¸ÝáâàãÚæØØ ßÞ ãáâÐÝÞÒÚÕ ßÐàÐÜÕâàÞÒ ÔÛï àÐÑÞâë Ò áÕâØ ¸ÝâÕàÝÕâ ÜÞÖÝÞ 
ßÞÛãçØâì ã ßÞáâÐÒéØÚÐ ãáÛãÓ ¸ÝâÕàÝÕâ. ÁâàÞÓÞ áÛÕÔãÙâÕ ßÞÛãçÕÝÝëÜ 
ØÝáâàãÚæØïÜ.

¿àØÜÕçÐÝØÕ. ´Ûï ßÞÔÚÛîçÕÝØï Ú áÕâØ ¸ÝâÕàÝÕâ ÝÕÞÑåÞÔØÜÞ áÛÕÔãîéÕÕ: 
âÕÛÕäÞÝ ÒÚÛîçÕÝ Ø ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ 
áÕâØ, ÞâáãâáâÒãîâ ÐÚâØÒÝëÕ ÓÞÛÞáÞÒëÕ Òë×ÞÒë ØÛØ Òë×ÞÒë Ò 
àÕÖØÜÕ ßÕàÕÔÐçØ ÔÐÝÝëå.

ÃáâÐÝÞÒÛÕÝØÕ áÞÕÔØÝÕÝØï á ¸ÝâÕàÝÕâ

1 ½ÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï Internet ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.
2 ²ëÑÕàØâÕ âàÕÑãÕÜÞÕ ßàØÛÞÖÕÝØÕ (ÝÐßàØÜÕà, WWW) Ø ÝÐÖÜØâÕ Open 

(¾âÚàëâì). ºÞÓÔÐ ßàØÛÞÖÕÝØî ßÞâàÕÑãÕâáï ãáâÐÝÞÒØâì áÞÕÔØÝÕÝØÕ, 
ÞâÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ, Ò ÚÞâÞàÞÜ ÒëÒÕÔÕÝë ßÞÛï Connection name 
(½Ð×ÒÐÝØÕ áÞÕÔØÝÕÝØï) Ø Phone number (ÂÕÛÕäÞÝÝëÙ ÝÞÜÕà) ßãÝÚâÐ ÔÞáâãßÐ 
IAP, ØáßÞÛì×ãÕÜÞÓÞ ÔÛï ãáâÐÝÞÒÛÕÝØï áÞÕÔØÝÕÝØï. 

3 ´Ûï ãáâÐÝÞÒÛÕÝØï áÞÕÔØÝÕÝØï ÝÐÖÜØâÕ OK.
4 ½ÐÖÜØâÕ Done (³ÞâÞÒÞ), çâÞÑë ×ÐÚàëâì ßàØÛÞÖÕÝØÕ.
5 ´Ûï ÞâÚÛîçÕÝØï Þâ áÕâØ ¸ÝâÕàÝÕâ ÝÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï Internet 

Ò ÛîÑÞÜ Ø× ßàØÛÞÖÕÝØÙ ¸ÝâÕàÝÕâ, ×ÐâÕÜ ÝÐÖÜØâÕ Disconnect 
(ÀÐ×êÕÔØÝØâì). ÀÐ×êÕÔØÝÕÝØÕ ÒëßÞÛÝïÕâáï ÝÕÜÕÔÛÕÝÝÞ.
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Þ±àÐã×Õà WWW

WWW — íâÞâ ÓØßÕàâÕÚáâÞÒÐï áØáâÕÜÐ, ßàÕÔÝÐ×ÝÐçÕÝÝÐï ÔÛï ßÞØáÚÐ Ø ÔÞáâãßÐ 
Ú àÕáãàáÐÜ ¸ÝâÕàÝÕâ. ´Ûï ßàÞáÜÞâàÐ áÕâØ ¸ÝâÕàÝÕâ:

¿àØÜÕà. ¿àØÜÕà ÐÔàÕáÐ 
URL: www.nokia.com.

ÁÞÒÕâ. ´Ûï ×ÐÓàã×ÚØ 
ÝÕÚÞâÞàëå áâàÐÝØæ WWW 
âàÕÑãÕâáï ãÚÐ×Ðâì ØÜï 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛì. 
²ÒÕÔÕÝÝëÕ ØÜï 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛì 
áÞåàÐÝïîâáï Ò ßÐÜïâØ 
ÚÞÜÜãÝØÚÐâÞàÐ Ø 
ØáßÞÛì×ãîâáï ßàØ 
ÞçÕàÕÔÝÞÜ ÔÞáâãßÕ Ú íâÞÙ 
áâàÐÝØæÕ.

1 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > Open > Web page…
2 ²ÒÕÔØâÕ ÐÔàÕá URL Ò ßÞÛÕ ÐÔàÕáÐ ØÛØ ÒëÑÕàØâÕ ×ÐÚÛÐÔÚã Ø× áßØáÚÐ 

×ÐÚÛÐÔÞÚ, ×ÐâÕÜ ÝÐÖÜØâÕ Go to (¿ÕàÕÙâØ). ¼ÞÖÝÞ âÐÚÖÕ ßÕàÕåÞÔØâì ÝÐ 
ÔàãÓØÕ web-áâàÐÝØæë á ÝÐçÐÛìÝÞÙ áâàÐÝØæë ÑàÐã×ÕàÐ WWW.

3 ¿ÞáÛÕ âÞÓÞ, ÚÐÚ áâàÐÝØæÐ ×ÐÓàãÖÕÝÐ Ø ÞâÚàëâÐ, ÔÛï ÒëÑÞàÐ ááëÛÞÚ Ø 
ÐÚâØÒÝëå ÞÑÛÐáâÕÙ ØáßÞÛì×ãÕâáï ÚÛÐÒØèÐ Tab. ´Ûï ßÕàÕåÞÔÐ ÝÐ×ÐÔ 
ÝÐÖÜØâÕ Shift+Tab. ¼ÞÖÝÞ âÐÚÖÕ ÒÞáßÞÛì×ÞÒÐâìáï ØÝáâàãÜÕÝâÞÜ Pointer 
(ÃÚÐ×ÐâÕÛì), ÚÞâÞàëÙ ÒÚÛîçÐÕâáï ÚÞÜÑØÝÐæØÕÙ ÚÛÐÒØè Ctrl + Q. 
´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï ßÞ ØÝáâàãÜÕÝâã Pointer ßàØÒÕÔÕÝÐ 
Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ.

4 ¿ÕàÕÙÔØâÕ ÝÐ ÔàãÓãî áâàÐÝØæã ØÛØ web-ã×ÕÛ, ÒëÑÕàØâÕ ÓØßÕàááëÛÚã ØÛØ 
ÐÚâØÒÝãî ÞÑÛÐáâì Ø ÝÐÖÜØâÕ Go to.

¿àØÛÞÖÕÝØÕ WAP
¿àØÛÞÖÕÝØÕ WAP — íâÞ ÓØßÕàâÕÚáâÞÒÐï áØáâÕÜÐ, ßàÕÔÝÐ×ÝÐçÕÝÝÐï ÔÛï 
ÔÞáâãßÐ Ú ãáÛãÓÐÜ ¸ÝâÕàÝÕâ, áÞÔÕàÖÐéØÜ ÝÞÒÞáâØ, ßàÞÓÝÞ×ë ßÞÓÞÔë, 
àÐáßØáÐÝØï ÔÒØÖÕÝØï âàÐÝáßÞàâÐ, áÛÞÒÐàØ Ø ßà. ÍâÞ áØáâÕÜÐ ÞàØÕÝâØàÞÒÐÝÐ 
ÝÐ ßÞÛì×ÞÒÐâÕÛÕÙ ÜÞÑØÛìÝëå áàÕÔáâÒ áÒï×Ø.

´Ûï ßÞÛãçÕÝØï ÔÞáâãßÐ Ú ãáÛãÓÐÜ WAP ÝÕÞÑåÞÔØÜÞ ÒëßÞÛÝÕÝØÕ áÛÕÔãîéØå 
ãáÛÞÒØÙ: 
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Þ • âÕÛÕäÞÝ ÝÐåÞÔØâáï Ò ×ÞÝÕ ÞÑáÛãÖØÒÐÝØï áÞâÞÒÞÙ áÕâØ, ßàÕÔÞáâÐÒÛïîéÕÙ 
ãáÛãÓã ßÕàÕÔÐçØ ÔÐÝÝëå;

• ãáÛãÓÐ ßÕàÕÔÐçØ ÔÐÝÝëå ßÞÔÔÕàÖØÒÐÕâáï SIM-ÚÐàâÞÙ;
• ßÞáâÐÒéØÚ ãáÛãÓ WAP ßàÕÔÞáâÐÒØÛ ÔÐÝÝëÕ ßãÝÚâÐ ÔÞáâãßÐ Ú ãáÛãÓÐÜ WAP 

Ø
• Ò ßÐÜïâì ÚÞÜÜãÝØÚÐâÞàÐ ÒÒÕÔÕÝë ßÐàÐÜÕâàë ÔÞáâãßÐ Ú ãáÛãÓÐÜ WAP. 

²ëßÞÛÝØâÕ ØÝáâàãÚæØØ, ßàØÒÕÔÕÝÝëÕ Ò àãÚÞÒÞÔáâÒÕ ßÞ íÚáßÛãÐâÐæØØ.

´Þáâãß Ú ãáÛãÓÐÜ WAP

´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì áâàÐÝØæã WAP:

1 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > Open page. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ. ²ÒÕÔØâÕ ÐÔàÕá URL, ÝÐßàØÜÕà, mobile.club.nokia.com.

2 Á ßÞÜÞéìî ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÜÞÖÝÞ ßàÞÚàãâØâì áâàÐÝØæã ÔÛï 
ÒëÑÞàÐ ÓØßÕàááëÛÞÚ Ø ÐÚâØÒÝëå ÞÑÛÐáâÕÙ.

¿àØÜÕçÐÝØÕ. ́ Ûï ÔÞáâãßÐ Ú ÝÕÚÞâÞàëÜ áÕàÒÕàÐÜ, ÝÐ ÚÞâÞàëå ãáâÐÝÞÒÛÕÝÐ 
áØáâÕÜÐ ãßàÐÒÛÕÝØï ÔÞáâãßÞÜ, âàÕÑãÕâáï ÒÒÕáâØ ØÜï 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛì. ² íâÞÜ áÛãçÐÕ ßÕàÕÔ ãáâÐÝÞÒÛÕÝØÕÜ 
áÞÕÔØÝÕÝØï á ãáÛãÓÞÙ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï ×ÐßàÞá ØÜÕÝØ 
ßÞÛì×ÞÒÐâÕÛï Ø ßÐàÞÛï.

¿àØÛÞÖÕÝØÕ Contacts
´Ûï ×ÐßãáÚÐ ßàØÛÞÖÕÝØï Contacts (ºÞÝâÐÚâë) ÝÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï 
Contacts ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ. ¿àØÛÞÖÕÝØÕ Contacts ßàÕÔÝÐ×ÝÐçÕÝÞ 
ÔÛï áÞ×ÔÐÝØï, àÕÔÐÚâØàÞÒÐÝØï Ø ÞàÓÐÝØ×ÐæØØ ßÕàáÞÝÐÛìÝÞÙ ØÝäÞàÜÐæØØ, 
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ÞâÐÚÞÙ ÚÐÚ âÕÛÕäÞÝÝëÕ ÝÞÜÕàÐ Ø ÐÔàÕáÐ. ÍÛÕÜÕÝâë ÚÐâÐÛÞÓÐ Contacts 

ÝÐ×ëÒÐîâáï ÒØ×ØâÝëÜØ ÚÐàâÞçÚÐÜØ. ¸ÝäÞàÜÐæØî Þ ÚÞÝâÐÚâÐå ÜÞÖÝÞ 
áØÝåàÞÝØ×ØàÞÒÐâì á áÞÒÜÕáâØÜëÜ ßÕàáÞÝÐÛìÝëÜ ÚÞÜßìîâÕàÞÜ.

³ÛÐÒÝÐï ÑÐ×Ð ÔÐÝÝëå ÚÞÝâÐÚâÞÒ ÝÐåÞÔØâáï Ò ßÐÜïâØ ÚÞÜÜãÝØÚÐâÞàÐ. ºÞÝâÐÚâë 
ÜÞÖÝÞ âÐÚÖÕ áÞåàÐÝïâì Ò ÞâÔÕÛìÝëå ÑÐ×Ðå ÔÐÝÝëå ÝÐ ßÞÔÚÛîçÕÝÝÞÙ ÚÐàâÕ 
ßÐÜïâØ.

ÁÞ×ÔÐÝØÕ ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ
1 ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Contacts ÝÐÖÜØâÕ New card (½ÞÒÐï 

ÚÐàâÞçÚÐ).
2 ² ßÞïÒØÒèÕÜáï ÝÐ ÔØáßÛÕÕ ÑÛÐÝÚÕ ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ ÒÒÕÔØâÕ 

ÝÕÞÑåÞÔØÜëÕ ÔÐÝÝëÕ Ò áÞÞâÒÕâáâÒãîéØÕ ßÞÛï.
3 ´Ûï áÞåàÐÝÕÝØï ÒØ×ØâÝÞÙ ÚÐàâÞçÚØ ÝÐÖÜØâÕ Done (³ÞâÞÒÞ).

²ë×ÞÒ ÚÞÝâÐÚâÐ
³ÛÐÒÝëÙ íÚàÐÝ ßàØÛÞÖÕÝØï Contacts àÐ×ÔÕÛÕÝ ÝÐ ÔÒÐ ÞÚÝÐ — ÛÕÒÞÕ Ø ßàÐÒÞÕ. 
´Ûï ßÕàÕåÞÔÐ Ò ßàÐÒÞÕ ÞÚÝÞ ÝÐÖÜØâÕ ÚÛÐÒØèã Tab. ²ëÔÕÛØâÕ âÕÛÕäÞÝÝëÙ 
ÝÞÜÕà ÚÞÝâÐÚâÐ Ø ÝÐÖÜØâÕ Call (²ë×ÞÒ).
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Þ ¿àØÛÞÖÕÝØÕ Calendar
¿àØÛÞÖÕÝØÕ Calendar (ºÐÛÕÝÔÐàì) ßÞ×ÒÞÛïÕâ áÛÕÔØâì ×Ð ×ÐßÛÐÝØàÞÒÐÝÝëÜØ 
áÞÑëâØïÜØ, ÜÕàÞßàØïâØïÜØ, îÑØÛÕÙÝëÜØ ÔÐâÐÜØ, ÔÝïÜØ àÞÖÔÕÝØï Ø ßà. ́ Ûï 
ÛîÑÞÙ ×ÐßØáØ ÚÐÛÕÝÔÐàï ÜÞÖÝÞ ãáâÐÝÞÒØâì ×ÒãÚÞÒãî áØÓÝÐÛØ×ÐæØî. ´Ûï 
×ÐßãáÚÐ ßàØÛÞÖÕÝØï Calendar (ºÐÛÕÝÔÐàì) ÝÐÖÜØâÕ ÚÛÐÒØèã ßàØÛÞÖÕÝØï 
Calendar ÝÐ ÚÛÐÒØÐâãàÕ ÚÞÜÜãÝØÚÐâÞàÐ.

¿àØ ßÞÔÚÛîçÕÝØØ ÚÞÜÜãÝØÚÐâÞàÐ Ú áÞÒÜÕáâØÜÞÜã ¿º ÒÞ×ÜÞÖÝÐ 
áØÝåàÞÝØ×ÐæØï ÚÐÛÕÝÔÐàï Ø ×ÐÔÐÝØÙ á ßàÞÓàÐÜÜÐÜØ Microsoft Windows Ø 
Lotus.

ÁÞ×ÔÐÝØÕ ÝÞÒÞÙ ×ÐßØáØ ÚÐÛÕÝÔÐàï
ÁÐÜëÙ ßàÞáâÞÙ áßÞáÞÑ áÞ×ÔÐÝØï ×ÐßØáØ ÚÐÛÕÝÔÐàï:

1 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > New entry. ²ëÑÕàØâÕ âØß ÝÞÒÞÙ 
×ÐßØáØ: Appointment… (²áâàÕçÐ), Event… (ÁÞÑëâØÕ), Anniversary… (³ÞÔÞÒéØÝÐ) 
ØÛØ Task… (·ÐÔÐÝØÕ).

2 ²ÒÕÔØâÕ ÝÕÞÑåÞÔØÜãî ØÝäÞàÜÐæØî Ò ßÞÛï ÝÐ áâàÐÝØæÐå ÔØÐÛÞÓÞÒÞÓÞ 
ÞÚÝÐ.

¾Ñ×Þà ÜÕáïæÐ
¾Ñ×Þà ÜÕáïæÐ — íâÞ ÓÛÐÒÝëÙ íÚàÐÝ ßàØÛÞÖÕÝØï Calendar. µáÛØ ÔÛï ÚÐÚÞÓÞ-
ÛØÑÞ ÜÕáïæÐ Ò ÚÐÛÕÝÔÐàÕ ÒÒÕÔÕÝÐ ØÝäÞàÜÐæØï, á ßàÐÒÞÙ áâÞàÞÝë íÚàÐÝÐ 
ÒëÒÞÔØâáï áßØáÞÚ áÞÑëâØÙ. ´Ûï Ø×ÜÕÝÕÝØï áÞÑëâØï:

1 ²ëÔÕÛØâÕ ßàÐÒÞÕ ÞÚÝÞ, ÝÐÖÐÒ ÚÛÐÒØèã Enter ØÛØ Edit day (¸×ÜÕÝØâì ÔÕÝì).
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Þ2 ²ëÑÕàØâÕ áÞÑëâØÕ Ø ÝÐÖÜØâÕ Edit (¸×ÜÕÝØâì). ½Ð ÔØáßÛÕÕ ßÞïÒØâáï ÞÚÝÞ 

ÔÐÝÝëå áÞÑëâØï.
3 ¸×ÜÕÝØâÕ ÔÐÝÝëÕ áÞÑëâØï, ÚÐÚ ÝÕÞÑåÞÔØÜÞ.

¾Ñ×Þà ÝÕÔÕÛØ
¾Ñ×Þà ÝÕÔÕÛØ áÞÔÕàÖØâ áÞÑëâØï, ×ÐßÛÐÝØàÞÒÐÝÝëÕ ÝÐ ÒëÑàÐÝÝãî ÝÕÔÕÛî. 
´Ûï ßÕàÕåÞÔÐ Ò àÕÖØÜ ÞÑ×ÞàÐ ÝÕÔÕÛØ ÝÐÖÜØâÕ Change view (¸×ÜÕÝØâì ÒØÔ) Ø 
ÒëÑÕàØâÕ Week (½ÕÔÕÛï).

¾Ñ×Þà ÔÝï
² àÕÖØÜÕ ÞÑ×ÞàÐ ÔÝï ÞâÞÑàÐÖÐîâáï áÞÑëâØï, ×ÐßÛÐÝØàÞÒÐÝÝëÕ ÝÐ 
ÒëÑàÐÝÝëÙ ÔÕÝì. ´Ûï ßÕàÕåÞÔÐ Ò àÕÖØÜ ÞÑ×ÞàÐ ÔÝï ÝÐÖÜØâÕ Change view Ø 
ÒëÑÕàØâÕ Day (´ÕÝì). 

¾Ñ×Þà ×ÐÔÐÝØÙ
² àÕÖØÜÕ ÞÑ×ÞàÐ ×ÐÔÐÝØÙ ÞâÞÑàÐÖÐÕâáï ÞÔØÝ áßØáÞÚ ×ÐÔÐÝØÙ. ÀÕÖØÜ ÞÑ×ÞàÐ 
×ÐÔÐÝØÙ ßÞ×ÒÞÛïÕâ ßàÞáÜÞâàÕâì Ø ÞàÓÐÝØ×ÞÒÐâì ×ÐÔÐÝØï. ½ÐßàØÜÕà, ÜÞÖÝÞ 
ãáâÐÝÞÒØâì ÔÐâã ×ÐÒÕàèÕÝØï Ø ßàØÞàØâÕâ ×ÐÔÐÝØï. ¼ÞÖÝÞ âÐÚÖÕ áÞ×ÔÐâì 
ÝÕáÚÞÛìÚÞ áßØáÚÞÒ ×ÐÔÐÝØÙ, ÝÐßàØÜÕà, ÔÛï ÔÕÛÞÒëå Ø ÛØçÝëå ÜÕàÞßàØïâØÙ. 

´àãÓØÕ àÕÖØÜë ÞÑ×ÞàÐ
² ÚÞÜÜãÝØÚÐâÞàÕ ßàÕÔãáÜÞâàÕÝë Ø ÔàãÓØÕ àÕÖØÜë ÞÑ×ÞàÐ, âÐÚØÕ ÚÐÚ 
ÕÖÕÓÞÔÝØÚ Ø áßØáÞÚ îÑØÛÕÕÒ.
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Þ ³àãßßÐ ßàØÛÞÖÕÝØÙ Office
³àãßßÐ ßàØÛÞÖÕÝØÙ Office (¾äØá) áÞÔÕàÖØâ ßàØÛÞÖÕÝØï Word, Sheet, 
Presentation viewer Ø File manager (ÒáÕ ÞÝØ áÞÒÜÕáâØÜë á Microsoft Windows).

ÁÞ×ÔÐÝØÕ ÔÞÚãÜÕÝâÐ Word
¿àØ ×ÐßãáÚÕ ßàØÛÞÖÕÝØï Word (âÕÚáâÞÒëÙ àÕÔÐÚâÞà) ÞâÚàëÒÐÕâáï ÝÞÒëÙ 
ÔÞÚãÜÕÝâ. ÁàÐ×ã ÖÕ ßÞáÛÕ íâÞÓÞ ÜÞÖÝÞ ÝÐçÐâì ÒÒÞÔ âÕÚáâÐ.

´Ûï áÞåàÐÝÕÝØï ÔÞÚãÜÕÝâÐ ÝÐÖÜØâÕ Close (·ÐÚàëâì). ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ 
ÞÚÝÞ. ² íâÞÜ ÞÚÝÕ ÝÕÞÑåÞÔØÜÞ ÒÒÕáâØ ØÜï ÔÞÚãÜÕÝâÐ Ø ÒëÑàÐâì ßÐßÚã ÔÛï 
áÞåàÐÝÕÝØï ÔÞÚãÜÕÝâÐ.

¿àØÛÞÖÕÝØÕ Sheet
¿àØ àÐÑÞâÕ Ò ßàØÛÞÖÕÝØØ Sheet (ÂÐÑÛØæÐ) ÔÐÝÝëÕ åàÐÝïâáï Ò äÐÙÛÐå, 
ÝÐ×ëÒÐÕÜëå àÐÑÞçØÜØ ÚÝØÓÐÜØ. ºÐÖÔÐï àÐÑÞçÐï ÚÝØÓÐ áÞÔÕàÖØâ ÝÕ ÜÕÝÕÕ 
ÞÔÝÞÙ âÐÑÛØæë. ÀÐÑÞçÐï ÚÝØÓÐ ÜÞÖÕâ âÐÚÖÕ áÞÔÕàÖÐâì ÔØÐÓàÐÜÜë; 
ÔØÐÓàÐÜÜÐ — íâÞ âÐÑÛØçÝëÙ ÔÞÚãÜÕÝâ, Ò ÚÞâÞàÞÜ ÔÐÝÝëÕ âÐÑÛØæë 
ßàÕÔáâÐÒÛÕÝë Ò ÓàÐäØçÕáÚÞÜ äÞàÜÐâÕ.

ÁÞ×ÔÐÝØÕ àÐÑÞçÕÙ ÚÝØÓØ Ø âÐÑÛØæ

ÁÞÒÕâ. ´Ûï áÞ×ÔÐÝØï 
âÐÑÛØæë Ò ßàØÛÞÖÕÝØØ 
Desk ÝÐÖÜØâÕ ÚÛÐÒØèã 
Menu Ø ÒëÑÕàØâÕ File > Add 
to Desk.

´Ûï áÞ×ÔÐÝØï ÝÞÒÞÙ àÐÑÞçÕÙ ÚÝØÓØ ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ File > 
New workbook.

´Ûï áÞåàÐÝÕÝØï àÐÑÞçÕÙ ÚÝØÓØ ÝÐÖÜØâÕ ÚÛÐÒØèã Menu ÝÐ íÚàÐÝÕ âÐÑÛØæë Ø 
ÒëÑÕàØâÕ File > Save.
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Þ´Ûï áÞ×ÔÐÝØï ÝÞÒÞÙ âÐÑÛØæë Ò àÐÑÞçÕÙ ÚÝØÓÕ ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø 

ÒëÑÕàØâÕ Insert > New worksheet.

´Ûï âÞÓÞ, çâÞÑë ÒÒÕáâØ ÔÐÝÝëÕ, ÒëÑÕàØâÕ ïçÕÙÚã á ßÞÜÞéìî ÚÛÐÒØè áÞ 
áâàÕÛÚÐÜØ Ø ÒÒÕÔØâÕ âàÕÑãÕÜãî ØÝäÞàÜÐæØî Ò ÒëÑàÐÝÝãî ïçÕÙÚã.

´Ûï ßÞÔâÒÕàÖÔÕÝØï ÒÒÞÔÐ ÔÐÝÝëå Ò ïçÕÙÚã ÝÐÖÜØâÕ ÚÛÐÒØèã Enter, OK ØÛØ 
ßÕàÕÙÔØâÕ Ò ÔàãÓãî ïçÕÙÚã á ßÞÜÞéìî ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ. ´Ûï ÞâÜÕÝë 
ÞßÕàÐæØØ ÝÐÖÜØâÕ ÚÛÐÒØèã Esc ØÛØ Cancel (¾âÜÕÝØâì).

´Ûï ÞßàÕÔÕÛÕÝØï ÚÐâÕÓÞàØØ ÔÛï ÔÐÝÝëå Ò ïçÕÙÚÕ ÝÐÖÜØâÕ Function 
(ÄãÝÚæØï). ¿àÕÔãáÜÞâàÕÝë áÛÕÔãîéØÕ ÚÐâÕÓÞàØØ: All (²áÕ), Financial 
(ÄØÝÐÝáÞÒëÕ ÔÐÝÝëÕ), Date and time (´ÐâÐ Ø ÒàÕÜï), Mathematical 
(¼ÐâÕÜÐâØçÕáÚØÕ ÔÐÝÝëÕ), Statistical (ÁâÐâØáâØçÕáÚØÕ ÔÐÝÝëÕ), Lookup (¿ÞØáÚ), 
Text (ÂÕÚáâ), Logical (»ÞÓØçÕáÚØÕ ÔÐÝÝëÕ) Ø Information (¸ÝäÞàÜÐæØï). ºÐÖÔÞÙ 
ÚÐâÕÓÞàØØ áÞÞâÒÕâáâÒãÕâ ÝÐÑÞà äãÝÚæØÙ, ÚÞâÞàëÙ ÞâÞÑàÐÖÐÕâáï Ò áßØáÚÕ 
àïÔÞÜ á ßÞÛÕÜ Function name (¸Üï äãÝÚæØØ).

ÁÞ×ÔÐÝØÕ ÔØÐÓàÐÜÜ

¿àÕÔãáÜÞâàÕÝÞ áÕÜì àÐ×ÛØçÝëå âØßÞÒ ÔØÐÓàÐÜÜ: Column (ÁâÞÛÑçÐâÐï), 
Stacked column (ÈâÐÑÕÛìÝÐï áâÞÛÑçÐâÐï), Line (»ØÝÕÙÝÐï), Pie (ÁÕÚâÞàÝÐï), Bar 
(³ØáâÞÓàÐÜÜÐ), Stacked bar (ÈâÐÑÕÛìÝÐï ÓØáâÞÓàÐÜÜÐ) Ø X/Y scatter (³àÐäØÚ X/Y).

1 ²ëÑÕàØâÕ ÔØÐßÐ×ÞÝ ïçÕÕÚ âÐÑÛØæë, ÚÞâÞàëÕ áÞÔÕàÖÐâ ÔÐÝÝëÕ ÔÛï ÝÞÒÞÙ 
ÔØÐÓàÐÜÜë.

2 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu Ø ÒëÑÕàØâÕ Insert > New chart (½ÞÒÐï ÔØÐÓàÐÜÜÐ). 
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.

3 ²ÒÕÔØâÕ áÛÕÔãîéØÕ ÔÐÝÝëÕ: Chart name (½Ð×ÒÐÝØÕ ÔØÐÓàÐÜÜë), Chart type 
(ÂØß ÔØÐÓàÐÜÜë), 3-D, Background colour (ÆÒÕâ äÞÝÐ) Ø Axis colour (ÆÒÕâ ÞáÕÙ).
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Þ 4 ½ÐÖÜØâÕ Close (·ÐÚàëâì) ÔÛï áÞ×ÔÐÝØï ÝÞÒÞÙ ÔØÐÓàÐÜÜë ØÛØ Cancel ÔÛï 
ÞâÜÕÝë ÞßÕàÐæØØ.

¿àØÛÞÖÕÝØÕ Presentation viewer
´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì ßàÕ×ÕÝâÐæØî, ÝÐÖÜØâÕ Open (¾âÚàëâì) ÝÐ ÓÛÐÒÝÞÜ 
íÚàÐÝÕ ßàØÛÞÖÕÝØï Presentation viewer, ÚÞâÞàëÙ ßÞ×ÒÞÛïÕâ ÒëÑàÐâì Ø ÞâÚàëâì 
ÔÞÚãÜÕÝâ. ½ÐÖÜØâÕ Close (·ÐÚàëâì), çâÞÑë ×ÐÚàëâì ßàØÛÞÖÕÝØÕ.

ÁÞÒÕâ. ²ëÑÕàØâÕ 
ÜÐáèâÐÑ Ø×ÞÑàÐÖÕÝØï, 
ÝÐØÑÞÛÕÕ ãÔÞÑÝëÙ ÔÛï 
ßàÞáÜÞâàÐ ßàÕ×ÕÝâÐæØØ.

¿ÞáÛÕ ÞâÚàëâØï ÔÞÚãÜÕÝâÐ ÝÐ ÔØáßÛÕÙ ÒëÒÞÔØâáï ÒÕàåÝïï çÐáâì ßÕàÒÞÓÞ 
áÛÐÙÔÐ. ´Ûï ßÕàÕåÞÔÐ Ú áÛÕÔãîéÕÜã áÛÐÙÔã ÝÐÖÜØâÕ Next (ÁÛÕÔãîéØÙ) ØÛØ 
Enter. ´Ûï ßÕàÕåÞÔÐ Ú ßàÕÔëÔãéÕÜã áÛÐÙÔã ÝÐÖÜØâÕ Previous (¿àÕÔëÔãéØÙ). 
´Ûï ßàÞÚàãâÚØ âÕÚãéÕÓÞ áÛÐÙÔÐ ßÞÛì×ãÙâÕáì ÚÛÐÒØèÐÜØ áÞ áâàÕÛÚÐÜØ.

¿àØÛÞÖÕÝØÕ File manager
¿àØÛÞÖÕÝØÕ File manager (´ØáßÕâçÕà äÐÙÛÞÒ) áÛãÖØâ ÔÛï ãßàÐÒÛÕÝØï 
áÞÔÕàÖØÜëÜ àÐ×ÛØçÝëå ßÐßÞÚ Ø Øå áÒÞÙáâÒÐÜØ.

² ÞÚÝÕ ßÐßÞÚ ÞâÞÑàÐÖÐÕâáï ÔÕàÕÒÞ, áÞÔÕàÖÐéÕÕ ßÐßÚØ ÔÒãå ÚÞàÝÕÒëå 
ÚÐâÐÛÞÓÞÒ: ÚÞÜÜãÝØÚÐâÞàÐ Ø ÚÐàâë ßÐÜïâØ.

² ÔÕàÕÒÕ ßÐßÞÚ ÚÞÜÜãÝØÚÐâÞàÐ ÝÐåÞÔØâáï ßÐßÚÐ \Documents\ (´ÞÚãÜÕÝâë), Ò 
ÚÞâÞàÞÙ àÐáßÞÛÞÖÕÝë çÕâëàÕ áâÐÝÔÐàâÝëÕ ßÐßÚØ: \Documents\Downloaded\ 
(·ÐÓàãÖÕÝÝëÕ ÔÞÚãÜÕÝâë), \Documents\Photo gallery\ (ÄÞâÞÐÛìÑÞÜ), 
\Documents\Templates\ (ÈÐÑÛÞÝë) Ø \Documents\Tones\ (ÂÞÝÐÛìÝëÕ áØÓÝÐÛë).
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Þ² ÞÚÝÕ äÐÙÛÞÒ ÞâÞÑàÐÖÐÕâáï áßØáÞÚ ÒáÕå äÐÙÛÞÒ, ÚÞâÞàëÕ áÞÔÕàÖÐâáï 

Ò ÚÞàÝÕÒÞÜ ÚÐâÐÛÞÓÕ ØÛØ ßÐßÚÕ, ÒëÔÕÛÕÝÝÞÙ Ò ÛÕÒÞÜ ÞÚÝÕ. ² ×ÐÓÞÛÞÒÚÕ ÞÚÝÐ 
áßØáÚÐ äÐÙÛÞÒ ÒëÒÞÔØâáï ßãâì Ú ÒëÔÕÛÕÝÝÞÜã Ò ÔÐÝÝëÙ ÜÞÜÕÝâ äÐÙÛã. ¾ÚÝÞ 
äÐÙÛÞÒ âÐÚÖÕ áÞÔÕàÖØâ áÒï×ÐÝÝëÕ á ßàØÛÞÖÕÝØïÜØ ×ÝÐçÚØ, ØÜÕÝÐ Ø ÔÐâë 
ßÞáÛÕÔÝÕÓÞ Ø×ÜÕÝÕÝØï äÐÙÛÞÒ. ÄÐÙÛë ÞâÞÑàÐÖÐîâáï Ò ÐÛäÐÒØâÝÞÜ ßÞàïÔÚÕ.

´Ûï ßàÞáÜÞâàÐ áÞÔÕàÖØÜÞÓÞ ßÐßÚØ

1 ²ëÑÕàØâÕ ßÐßÚã Ò ÛÕÒÞÜ ÞÚÝÕ ÔÕàÕÒÐ ßÐßÞÚ Ø ÝÐÖÜØâÕ Open (¾âÚàëâì). 
¾âÚàÞÕâáï ÞÚÝÞ, áÞÔÕàÖÐéÕÕ ÒáÕ ßÐßÚØ Ø äÐÙÛë àÞÔØâÕÛìáÚÞÙ ßÐßÚØ.

2 ´Ûï ßàÞáÜÞâàÐ ÛîÑÞÙ ßÐßÚØ ÒëÑÕàØâÕ ÕÕ Ø ÝÐÖÜØâÕ Open.
3 ´Ûï ÒÞ×ÒàÐâÐ ÝÐ ÓÛÐÒÝëÙ íÚàÐÝ ÝÐÖÜØâÕ Done (³ÞâÞÒÞ).

´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì äÐÙÛ

1 ²ëÑÕàØâÕ äÐÙÛ Ø ÝÐÖÜØâÕ Open (¾âÚàëâì). ÄÐÙÛ ÑãÔÕâ ÞâÚàëâ 
Ò áÞÞâÒÕâáâÒãîéÕÜ ßàØÛÞÖÕÝØØ. 

2 ´Ûï ÒÞ×ÒàÐâÐ ÝÐ ÓÛÐÒÝëÙ íÚàÐÝ ÝÐÖÜØâÕ Close folder (·ÐÚàëâì ßÐßÚã).

´Ûï áÞ×ÔÐÝØï ÝÞÒÞÙ ßÐßÚØ

1 ² ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï File manager ÝÐÖÜØâÕ ÚÛÐÒØèã Menu Ø 
ÒëÑÕàØâÕ File > New folder. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ. 

2 ²ÒÕÔØâÕ ÝÐ×ÒÐÝØÕ ÝÞÒÞÙ ßÐßÚØ.

´Ûï ßÞØáÚÐ ßÐßÞÚ Ø äÐÙÛÞÒ

1 ²ëÑÕàØâÕ ßÐßÚã ØÛØ ÜÞÔãÛì ßÐÜïâØ, Ò ÚÞâÞàÞÜ âàÕÑãÕâáï ÒëßÞÛÝØâì 
ßÞØáÚ. 

2 ½ÐÖÜØâÕ ÚÛÐÒØèã Menu > Tools > Find…. ¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ. 
3 ²ÒÕÔØâÕ Ò ßÞÛÕ áâàÞÚã ßÞØáÚÐ. 
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Þ 4 ´Ûï ÞßàÕÔÕÛÕÝØï ÔÞßÞÛÝØâÕÛìÝëå ÚàØâÕàØÕÒ ßÞØáÚÐ ÝÐÖÜØâÕ Options 
(¿ÐàÐÜÕâàë).
´Ûï Ø×ÜÕÝÕÝØï ×ÝÐçÕÝØï íÛÕÜÕÝâÞÒ áßØáÚÐ ÝÐÖÜØâÕ Change (¸×ÜÕÝØâì). 
·ÐÒÕàèØÒ ÒÒÞÔ ÔÐÝÝëå, ÝÐÖÜØâÕ Close (·ÐÚàëâì).

5 ´Ûï ×ÐßãáÚÐ ßÞØáÚÐ ÝÐÖÜØâÕ Find (½ÐÙâØ).
´Ûï âÞÓÞ, çâÞÑë ßàÕàÒÐâì ßÞØáÚ, ÝÐÖÜØâÕ Stop (ÁâÞß).

6 ¿ÞáÛÕ ×ÐÒÕàèÕÝØï ßÞØáÚÐ ÝÐÖÜØâÕ Open (¾âÚàëâì), çâÞÑë ÞâÚàëâì 
ÝÐÙÔÕÝÝãî ßÐßÚã ØÛØ äÐÙÛ.
´Ûï ×ÐßãáÚÐ ÝÞÒÞÓÞ ßÞØáÚÐ ÝÐÖÜØâÕ New find (½ÞÒëÙ ßÞØáÚ).

7 ´Ûï ÒÞ×ÒàÐâÐ Ò ÓÛÐÒÝëÙ íÚàÐÝ ÝÐÖÜØâÕ Close.

³àãßßÐ Extras
´Ûï ÒëÒÞÔÐ ÝÐ ÔØáßÛÕÙ ×ÝÐçÚÞÒ ÔÞßÞÛÝØâÕÛìÝëå ßàØÛÞÖÕÝØÙ ÝÐÖÜØâÕ 
ÚÛÐÒØèã ßàØÛÞÖÕÝØï Extras. ´Ûï âÞÓÞ, çâÞÑë ×ÐßãáâØâì ßàØÛÞÖÕÝØÕ, á 
ßÞÜÞéìî ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÒëÔÕÛØâÕ ×ÝÐçÞÚ ßàØÛÞÖÕÝØï Ø ÝÐÖÜØâÕ 
Open (¾âÚàëâì). 

´ÞßÞÛÝØâÕÛìÝëÕ ßàØÛÞÖÕÝØï ÜÞÖÝÞ ãáâÐÝÞÒØâì á ÚÞÜßÐÚâ-ÔØáÚÐ Ø× 
ÚÞÜßÛÕÚâÐ ßÞáâÐÒÚØ.

¿àØÛÞÖÕÝØÕ Clock
¿àØÛÞÖÕÝØÕ Clock (ÇÐáë) ÒëÒÞÔØâ ÝÐ ÔØáßÛÕÙ ÜÕáâÝÞÕ ÒàÕÜï Ø ÔÐâã, Ð âÐÚÖÕ 
ÒàÕÜï Ò ÝÕáÚÞÛìÚØå ÔàãÓØå ÓÞàÞÔÐå Ø áâàÐÝÐå ÜØàÐ. ² áÞáâÐÒ ßàØÛÞÖÕÝØï 
âÐÚÖÕ ÒåÞÔØâ ÑãÔØÛìÝØÚ.
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Þ´Ûï ãáâÐÝÞÒÚØ ÑãÔØÛìÝØÚÐ

ÁÞÒÕâ. ·ÒãÚÞÒëÕ 
áØÓÝÐÛë ÔÛï áÞÑëâØÙ 
ÚÐÛÕÝÔÐàï 
ãáâÐÝÐÒÛØÒÐîâáï Ò 
ßàØÛÞÖÕÝØØ Calendar.

1 ½ÐÖÜØâÕ Alarm clock (±ãÔØÛìÝØÚ) ÝÐ ÓÛÐÒÝÞÜ íÚàÐÝÕ ßàØÛÞÖÕÝØï Clock. 
¾âÚàÞÕâáï ÞÚÝÞ ÑãÔØÛìÝØÚÐ.
°ÚâØÒÝëÕ Ò ÔÐÝÝëÙ ÜÞÜÕÝâ áØÓÝÐÛë ßÕàÕçØáÛÕÝë Ò áßØáÚÕ àïÔÞÜ á 
çÐáÐÜØ.

2 ´Ûï áÞ×ÔÐÝØï ÝÞÒÞÓÞ áØÓÝÐÛÐ ÝÐÖÜØâÕ New alarm (½ÞÒëÙ áØÓÝÐÛ).
´Ûï Ø×ÜÕÝÕÝØï áØÓÝÐÛÐ ÝÐÖÜØâÕ Edit alarm (¸×ÜÕÝØâì áØÓÝÐÛ).
¾âÚàÞÕâáï ÔØÐÛÞÓÞÒÞÕ ÞÚÝÞ.

3 ²ÒÕÔØâÕ ÔÐÝÝëÕ áØÓÝÐÛÐ ÑãÔØÛìÝØÚÐ, ÝÐßàØÜÕà, ÒàÕÜï (Time).
4 ´Ûï ßÞÔâÒÕàÖÔÕÝØï ÒÒÕÔÕÝÝëå ÔÐÝÝëå ÝÐÖÜØâÕ Close (·ÐÚàëâì).

´Ûï ÒëÚÛîçÕÝØï áØÓÝÐÛÐ ÑãÔØÛìÝØÚÐ

½ÐÖÜØâÕ Stop (ÁâÞß) ØÛØ ÛîÑãî ÚÛÐÒØèã ÝÐ ÚÛÐÒØÐâãàÕ ÚàëèÚØ âÕÛÕäÞÝÐ.

´Ûï âÞÓÞ, çâÞÑë ÞâÚÛîçØâì áØÓÝÐÛ ÑãÔØÛìÝØÚÐ ÝÐ ×ÐÔÐÝÝÞÕ ÒàÕÜï, ÝÐÖÜØâÕ 
Snooze (¿ÞÒâÞà).

¿àØÛÞÖÕÝØÕ Calculator
ºÐÛìÚãÛïâÞà ÜÞÖÕâ àÐÑÞâÐâì Ò ÔÒãå àÕÖØÜÐå: ÚÐÛìÚãÛïâÞà ÔÛï ßàÞáâëå 
ÐàØäÜÕâØçÕáÚØå ÒëçØáÛÕÝØÙ Ø ÚÐÛìÚãÛïâÞà ÔÛï áÛÞÖÝëå ÜÐâÕÜÐâØçÕáÚØå 
àÐáçÕâÞÒ.

¿àÕÔãáÜÞâàÕÝÞ ÔÒÐ áßÞáÞÑÐ ÒëßÞÛÝÕÝØï ÒëçØáÛÕÝØÙ: ßãâÕÜ ÒÒÞÔÐ áØÜÒÞÛÞÒ 
Ò ßÞÛÕ ÒÒÞÔÐ ØÛØ ßãâÕÜ ÒëÑÞàÐ áØÜÒÞÛÞÒ Ø× ßÞÛï äãÝÚæØÙ. ÀÕ×ãÛìâÐâ 
ÒëçØáÛïÕâáï ßÞáÛÕ ÝÐÖÐâØï ÚÛÐÒØèØ Enter ØÛØ =. ¿àÞæÕáá ÒëçØáÛÕÝØÙ Ø 
àÕ×ãÛìâÐâ ÞâÞÑàÐÖÐîâáï Ò ÞÚÝÕ ÒëÒÞÔÐ ÝÐ ÛÕÒÞÙ áâÞàÞÝÕ ÔØáßÛÕï. ´Ûï 
ßÕàÕÜÕéÕÝØï ÜÕÖÔã ßÞÛÕÜ ÒÒÞÔÐ, ÞÚÝÞÜ ÒëÒÞÔÐ Ø ßÞÛÕÜ äãÝÚæØÙ ÝÐÖÜØâÕ 
ÚÛÐÒØèã Tab ØÛØ Change focus (¸×ÜÕÝØâì äÞÚãá).
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Þ ¿àØÛÞÖÕÝØÕ Control panel
² ßàØÛÞÖÕÝØØ Control panel (¿ÐÝÕÛì ãßàÐÒÛÕÝØï) ÜÞÖÝÞ ßàÞáÜÞâàÕâì ØÛØ 
Ø×ÜÕÝØâì áÛÕÔãîéØÕ ßÐàÐÜÕâàë: Display (´ØáßÛÕÙ), Date and time (´ÐâÐ Ø 
ÒàÕÜï), Regional settings (ÀÕÓØÞÝÐÛìÝëÕ ÝÐáâàÞÙÚØ), Internet access (´Þáâãß Ú 
¸ÝâÕàÝÕâ), Profiles (¿àÞäØÛØ), Security (·ÐéØâÐ), Certificate manager (ÃßàÐÒÛÕÝØÕ 
áÕàâØäØÚÐâÐÜØ), Install/Remove software (ÃáâÐÝÞÒÚÐ/ãÔÐÛÕÝØÕ ßàÞÓàÐÜÜ), 
Default folder (¿ÐßÚÐ, ØáßÞÛì×ãÕÜÐï ßÞ ãÜÞÛçÐÝØî), Memory (¿ÐÜïâì) Ø About 
product (¾Ñ Ø×ÔÕÛØØ).

¸×ÜÕÝÕÝØÕ íâØå ßÐàÐÜÕâàÞÒ ÞÚÐ×ëÒÐÕâ ÒÛØïÝØÕ ÝÐ ÒáÕ ßàØÛÞÖÕÝØï 
ÚÞÜÜãÝØÚÐâÞàÐ.

´Ûï âÞÓÞ, çâÞÑë ÞâÚàëâì ßàØÛÞÖÕÝØÕ ÔÛï Ø×ÜÕÝÕÝØï ßÐàÐÜÕâàÞÒ, á ßÞÜÞéìî 
ÚÛÐÒØèØ áÞ áâàÕÛÚÐÜØ ÒëÑÕàØâÕ âàÕÑãÕÜëÙ ×ÝÐçÞÚ Ø ÝÐÖÜØâÕ Open 
(¾âÚàëâì).

¿àØÛÞÖÕÝØÕ Recorder
ÁÞÒÕâ. Á ßÞÜÞéìî 

ßàØÛÞÖÕÝØï Recorder 
(´ØÚâÞäÞÝ) ×ÐßØáëÒÐîâáï 
×ÒãÚØ Ø àÕçì, ÚÞâÞàëÕ 
×ÐâÕÜ ÜÞÖÝÞ ãáâÐÝÞÒØâì 
Ò ÚÐçÕáâÒÕ áØÓÝÐÛÞÒ 
Òë×ÞÒÐ. ¿ÞÔàÞÑÝÕÕ 
áÜ. ÀãÚÞÒÞÔáâÒÞ 
ßÞÛì×ÞÒÐâÕÛï.

¿àØÛÞÖÕÝØÕ Recorder (´ØÚâÞäÞÝ) ßÞ×ÒÞÛïÕâ ×ÐßØáëÒÐâì âÕÛÕäÞÝÝëÕ 
àÐ×ÓÞÒÞàë Ø ÓÞÛÞáÞÒëÕ ßÐÜïâÚØ. ºàÞÜÕ âÞÓÞ, ÒÞ×ÜÞÖÝÞ ßàÞáÛãèØÒÐÝØÕ Ø 
àÕÔÐÚâØàÞÒÐÝØÕ ×ÐßØáÕÙ Ø ÔàãÓØå ×ÒãÚÞÒëå äÐÙÛÞÒ.
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ÞÂÕÛÕäÞÝ

ÀØá. 12

²ÚÛîçÕÝØÕ âÕÛÕäÞÝÐ
1 ·ÐÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ (ÕáÛØ ÞÝÐ ÞâÚàëâÐ).
2 ´Ûï ÒÚÛîçÕÝØï âÕÛÕäÞÝÐ ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã . 

µáÛØ ÝÐ ÔØáßÛÕÕ ßÞïÒØâáï ×ÐßàÞá ÚÞÔÐ PIN, ÒÒÕÔØâÕ ÚÞÔ, ÚÞâÞàëÙ 
ßàÕÔÞáâÐÒÛïÕâáï ÒÜÕáâÕ á SIM-ÚÐàâÞÙ, Ø ÝÐÖÜØâÕ ÚÛÐÒØèã , 
àÐáßÞÛÞÖÕÝÝãî ßÞÔ âÕÚáâÞÜ OK ÝÐ ÔØáßÛÕÕ. 

ÂÕÛÕäÞÝ

´ØÝÐÜØÚ

²ØÔ áßÕàÕÔØ ²ØÔ á×ÐÔØ

¼ØÚàÞäÞÝ
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Þ ²°¶½¾µ ·°¼µÇ°½¸µ. ½ÕÛì×ï ÒÚÛîçÐâì àÐÔØÞâÕÛÕäÞÝ Ò âÐÚØå ÜÕáâÐå, 
ÓÔÕ ÕÓÞ ØáßÞÛì×ÞÒÐÝØÕ ×ÐßàÕéÕÝÞ ÛØÑÞ ÞÝ ÜÞÖÕâ ïÒÛïâìáï 
ØáâÞçÝØÚÞÜ ÞßÐáÝÞáâØ ØÛØ áÞ×ÔÐÒÐâì ßÞÜÕåØ.

¸ÝÔØÚÐâÞàë ÔØáßÛÕï
¸ÝÔØÚÐâÞàë ÔØáßÛÕï ßàÕÔÝÐ×ÝÐçÕÝë ÔÛï ÞâÞÑàÐÖÕÝØï áÞáâÞïÝØï âÕÛÕäÞÝÐ. 
¿ÕàÕçØáÛÕÝÝëÕ ÝØÖÕ ØÝÔØÚÐâÞàë ÒëÒÞÔïâáï ÝÐ ÔØáßÛÕÙ, ÚÞÓÔÐ âÕÛÕäÞÝ 
ÓÞâÞÒ Ú àÐÑÞâÕ Ø ÝÐ ÔØáßÛÕÕ ÞâáãâáâÒãîâ ÒÒÕÔÕÝÝëÕ ßÞÛì×ÞÒÐâÕÛÕÜ áØÜÒÞÛë.

½°·²°½¸µ ¸ »¾³¾Â¸¿ ÁµÂ¸

- ÃÚÐ×ëÒÐÕâ ÝÐ×ÒÐÝØÕ áÞâÞÒÞÙ áÕâØ, Ú ÚÞâÞàëÙ Ò ÔÐÝÝëÙ ÜÞÜÕÝâ ßÞÔÚÛîçÕÝ 
âÕÛÕäÞÝ.

 Ø èÚÐÛÐ ÝÐÔ áØÜÒÞÛÞÜ

- ¿ÞÚÐ×ëÒÐÕâ ãàÞÒÕÝì àÐÔØÞáØÓÝÐÛÐ Ò âÞçÚÕ àÐáßÞÛÞÖÕÝØï âÕÛÕäÞÝÐ. ÇÕÜ 
ÑÞÛìèÕ ßàïÜÞãÓÞÛìÝØÚÞÒ ÒØÔÝÞ ÝÐ ÔØáßÛÕÕ, âÕÜ ÑÞÛìèÕ ãàÞÒÕÝì áØÓÝÐÛÐ.

 Ø èÚÐÛÐ ÝÐÔ áØÜÒÞÛÞÜ

- ¿ÞÚÐ×ëÒÐÕâ ãàÞÒÕÝì ×ÐàïÔÐ ÐÚÚãÜãÛïâÞàÐ. ÇÕÜ ÑÞÛìèÕ ßàïÜÞãÓÞÛìÝØÚÞÒ 
ÒØÔÝÞ ÝÐ ÔØáßÛÕÕ, âÕÜ ÑÞÛìèÕ ãàÞÒÕÝì ×ÐàïÔÐ ÐÚÚãÜãÛïâÞàÐ.

¿ÞáëÛÚÐ Òë×ÞÒÞÒ Ø ÞâÒÕâ ÝÐ Òë×ÞÒë
´Ûï ßÞáëÛÚØ Òë×ÞÒÐ ÒÒÕÔØâÕ ÚÞÔ ×ÞÝë Ø âÕÛÕäÞÝÝëÙ ÝÞÜÕà, ×ÐâÕÜ 
ÝÐÖÜØâÕ .

´Ûï ÞâÒÕâÐ ÝÐ Òë×ÞÒ ÝÐÖÜØâÕ .

´Ûï ×ÐÒÕàèÕÝØï Òë×ÞÒÐ ÝÐÖÜØâÕ . 
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ÞºÛÐÒØèØ ÒëÑÞàÐ

¿ÕàÕÚÛîçÕÝØÕ ßàÞäØÛÕÙ.

 ¿àÞÚàãâÚÐ ÜÕÝî, ßÞÔÜÕÝî Ø ßÐàÐÜÕâàÞÒ. ² àÕÖØÜÕ ÞÖØÔÐÝØï 
(ÚÞÓÔÐ ÞâáãâáâÒãîâ ÐÚâØÒÝëÕ Òë×ÞÒë) ÚÛÐÒØèØ ßàÞÚàãâÚØ ÜÞÖÝÞ 
ØáßÞÛì×ÞÒÐâì ÔÛï ßàÞáÜÞâàÐ áÞÔÕàÖØÜÞÓÞ ßÐÜïâØ. ²Þ ÒàÕÜï àÐ×ÓÞÒÞàÐ 
ÚÛÐÒØèØ ßàÞÚàãâÚØ áÛãÖÐâ ÔÛï àÕÓãÛØàÞÒÚØ ÓàÞÜÚÞáâØ.

 –  ÆØäàÞÒëÕ ÚÛÐÒØèØ (âÐÚÖÕ ØáßÞÛì×ãîâáï ÔÛï ÒÒÞÔÐ ÑãÚÒ). ́ Ûï 
Òë×ÞÒÐ áÒÞÕÓÞ ÐÒâÞÞâÒÕâçØÚÐ ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã .

 ßàÕÔÝÐ×ÝÐçÕÝë ÔÛï ÒëßÞÛÝÕÝØï áßÕæØÐÛìÝëå äãÝÚæØÙ. ¿àØ 
ØáßÞÛì×ÞÒÐÝØØ ÔÒãå âÕÛÕäÞÝÝëå ÛØÝØÙ ÔÛï ßÕàÕÚÛîçÕÝØï ÜÕÖÔã ÛØÝØïÜØ 
ÝÐÖÜØâÕ Ø ãÔÕàÖØÒÐÙâÕ ÝÐÖÐâÞÙ ÚÛÐÒØèã . 

 ½Ð×ÝÐçÕÝØÕ íâØå ÔÒãå ÚÛÐÒØè ÒëÑÞàÐ ÞßàÕÔÕÛïÕâáï âÕÚáâÞÜ, 
ÚÞâÞàëÙ ÒëÒÞÔØâáï Ò ÝØÖÝÕÙ áâàÞÚÕ ÔØáßÛÕï.

¿àØÜÕçÐÝØÕ. ¼ØÚàÞäÞÝ Ø ÔØÝÐÜØÚ ÝÐåÞÔïâáï ÝÐ ÞÑàÐâÝÞÙ áâÞàÞÝÕ 
âÕÛÕäÞÝÐ.

ÄÞàãÜ Nokia
Nokia Wireless Data Forum — íâÞ web-ãáÛãÓÐ, ÐÔàÕáÞÒÐÝÝÐï âÕÜ, ÚâÞ 
×ÐÝØÜÐÕâáï àÐ×àÐÑÞâÚÞÙ ßàØÛÞÖÕÝØÙ Ø ãáÛãÓ ÔÛï ßÛÐâäÞàÜ Nokia. Web-ã×ÕÛ 
áÞÔÕàÖØâ ØÝäÞàÜÐæØî Þ àÐ×ÛØçÝëå ÒÞ×ÜÞÖÝÞáâïå àÐ×ÒØâØï, Ð âÐÚÖÕ Þ 
ÔÞáâãßÝëå ßàÞÓàÐÜÜÐå ÜÐàÚÕâØÝÓÞÒÞÙ ßÞÔÔÕàÖÚØ àÐ×àÐÑÞâçØÚÞÒ, áØáâÕÜÝëå 
ØÝâÕÓàÐâÞàÞÒ Ø ÔàãÓØå ßÐàâÝÕàÞÒ Nokia.
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Þ ºàÞÜÕ âÞÓÞ, Nokia Wireless Data Forum ßàÕÔÛÐÓÐÕâ ßÞÔÔÕàÖÚã ÚÞÜÜãÝØÚÐâÞàÐ 
Nokia 9210 Communicator Ø ÔàãÓØå Ø×ÔÕÛØÙ ÑÕáßàÞÒÞÔÝÞÙ áÒï×Ø Nokia. ½Ð íâØå 
web-áâàÐÝØæÐå ÜÞÖÝÞ ÝÐÙâØ ÔÞÚãÜÕÝâÐæØî, ÔàÐÙÒÕàë, ÞßØáÐÝØï, áÒÕÔÕÝØï Þ 
áÞÒÜÕáâØÜÞáâØ Ø â. ß.

´Ûï âÕå, ÚâÞ ØÝâÕàÕáãÕâáï ßÕàÕÔÐçÕÙ ÔÐÝÝëå ßÞ ÑÕáßàÞÒÞÔÝëÜ áÕâïÜ, web-
ã×ÕÛ ßàÕÔÛÐÓÐÕâ ÔÞÚãÜÕÝâÐæØî ßÞ àÐ×ÛØçÝëÜ âÕåÝÞÛÞÓØïÜ, áÒï×ÐÝÝëÜ 
á ÑÕáßàÞÒÞÔÝÞÙ ßÕàÕÔÐçÕÙ ÔÐÝÝëå.

°ÔàÕá Nokia Wireless Data Forum http://www.forum.nokia.com

Club Nokia
Club Nokia ßàÕÔÛÐÓÐÕâ ØáçÕàßëÒÐîéãî ØÝäÞàÜÐæØî, ÚÞâÞàÐï ßÞÜÞÖÕâ 
Ò ßÞÛÝÞÙ ÜÕàÕ ÒÞáßÞÛì×ÞÒÐâìáï ÒÞ×ÜÞÖÝÞáâïÜØ âÕÛÕäÞÝ Nokia. ² ÚÐçÕáâÒÕ 
çÛÕÝÐ Club Nokia ²ë ßÞÛãçÐÕâÕ ÔÞáâãß ÚÞ ÜÝÞÓÞçØáÛÕÝÝëÜ ßÞÛÕ×ÝëÜ 
ãáÛãÓÐÜ. ÁîÔÐ ÞâÝÞáïâáï ÞßÕàÐâØÒÝÞÕ ÞÑáÛãÖØÒÐÝØÕ Ø ßÞÔÔÕàÖÚÐ, 
ßàÕÔÒÐàØâÕÛìÝëÕ ÞÑ×Þàë ßàÞÔãÚæØØ Nokia, áßÕæØÐÛìÝëÕ ßàÕÔÛÞÖÕÝØï, 
ÔÞáâãß Ú web-ã×Ûã Club Nokia Ø â. ß.

µáÛØ ã ²Ðá ÒÞ×ÝØÚÝãâ ÒÞßàÞáë, áßÕæØÐÛØáâë ßÞ âÕÛÕäÞÝÐÜ Nokia ÒáÕÓÔÐ 
Ú ²ÐèØÜ ãáÛãÓÐÜ. ²ë ßÞÛãçÐÕâÕ áÒÞÑÞÔÝëÙ ÔÞáâãß Ú âÕÛÕäÞÝÝÞÜã æÕÝâàã 
áÞßàÞÒÞÖÔÕÝØï ßàÞÔãÚæØØ Club Nokia CareLine. ²ë âÐÚÖÕ ßÞÛãçÐÕâÕ ÔÞáâãß 
Ú áÛãÖÑÕ Club Nokia Instant Service — áÕàÒØáÝÞÜã æÕÝâàã ÔÛï 
×ÐàÕÓØáâàØàÞÒÐÝÝëå çÛÕÝÞÒ Club Nokia. ÁÕâì ÞÑáÛãÖØÒÐÝØï Club Nokia 
ÞåÒÐâëÒÐÕâ Òáî µÒàÞßã. 
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ÞÁÐÜëÙ ÞßÕàÐâØÒÝëÙ ÔÞáâãß Ú ãáÛãÓÐÜ Club Nokia, ØÝäÞàÜÐæØØ Þ ßàÞÔãÚæØØ, 

áßÕæØÐÛìÝëÜ ßàÕÔÛÞÖÕÝØïÜ, ÝÞÒÞáâïÜ Þ ßàÕÔáâÞïéØå áÞÑëâØïå Ø 
áÞàÕÒÝÞÒÐÝØïå — íâÞ web-ã×ÕÛ Club Nokia. Club Nokia ÔÞáâãßÕÝ Ò ÑÞÛìèØÝáâÒÕ 
ÕÒàÞßÕÙáÚØå áâàÐÝ - ÒáâãßÐÙâÕ ÑÕ× ÚÞÛÕÑÐÝØÙ Ò ÝÐè ÚÛãÑ! °ÔàÕá Club Nokia 
http://www.club.nokia.com.
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Ø2. ´ÞßÞÛÝØâÕÛìÝëÕ 

ßàØÝÐÔÛÕÖÝÞáâØ
ÁÞÒÕâ. ¿àØÜÕÝÕÝØÕ 

ÞàØÓØÝÐÛìÝëå 
ßàØÝÐÔÛÕÖÝÞáâÕÙ Nokia 
ÒÕáìÜÐ àÐ×ÝÞÞÑàÐ×ÝÞ: 
ÞÑÞàãÔÞÒÐÝØÕ 
ÒëáÞÚÞáÚÞàÞáâÝÞÙ 
ßÕàÕÔÐçØ ÔÐÝÝëå, 
ßàÐÚâØçÝëÕ 
ÜØÝØÓÐàÝØâãàë, 
ÐÒâÞÜÞÑØÛìÝëÕ Ø áÕâÕÒëÕ 
×ÐàïÔÝëÕ ãáâàÞÙáâÒÐ.

¾àØÓØÝÐÛìÝëÕ ßàØÝÐÔÛÕÖÝÞáâØ Nokia ÞÑÕáßÕçÐâ ÞßâØÜÐÛìÝãî àÐÑÞâã 
ÜÞÑØÛìÝÞÓÞ âÕÛÕäÞÝÐ Nokia Ò èØàÞÚÞÜ ÔØÐßÐ×ÞÝÕ ãáÛÞÒØÙ íÚáßÛãÐâÐæØØ. 
´ÞßÞÛÝØâÕÛìÝëÕ ßàØÝÐÔÛÕÖÝÞáâØ ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210 
Communicator àÐ×àÐÑÞâÐÝë ÔÛï ãÔÞÒÛÕâÒÞàÕÝØï ßÞâàÕÑÝÞáâÕÙ àÐ×ÛØçÝëå 
ÚÐâÕÓÞàØÙ ßÞÛì×ÞÒÐâÕÛÕÙ Ò àÐ×ÛØçÝëå ãáÛÞÒØïå áÒï×Ø.

¿àØÜÕçÐÝØÕ. ÁÛÕÔãÕâ ØáßÞÛì×ÞÒÐâì âÞÛìÚÞ âÕ ÐÚÚãÜãÛïâÞàÝëÕ ÑÐâÐàÕØ, 
×ÐàïÔÝëÕ ãáâàÞÙáâÒÐ Ø ßàØÝÐÔÛÕÖÝÞáâØ, ÚÞâÞàëÕ ÞÔÞÑàÕÝë 
Ø×ÓÞâÞÒØâÕÛÕÜ ÔÛï ÔÐÝÝÞÙ ÜÞÔÕÛØ ÚÞÜÜãÝØÚÐâÞàÐ. 
¸áßÞÛì×ÞÒÐÝØÕ ãáâàÞÙáâÒ ÛîÑëå ÔàãÓØå âØßÞÒ ßàØÒÞÔØâ 
Ú ÞâÜÕÝÕ ÒáÕå ÞâÝÞáïéØåáï Ú ÚÞÜÜãÝØÚÐâÞàã ÓÐàÐÝâØÙ Ø 
ßàÕÔáâÐÒÛïÕâ ãÓàÞ×ã ÑÕ×ÞßÐáÝÞáâØ.
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Ø ÃáâàÞÙáâÒÐ ßØâÐÝØï

±ÐâÐàÕï ßÞÒëèÕÝÝÞÙ ÜÞéÝÞáâØ BLL-3

ÀØá. 13

±ÐâÐàÕï ßÞÒëèÕÝÝÞÙ ÜÞéÝÞáâØ BLL-3 — íâÞ ßÛÞáÚØÙ, ÜÞéÝëÙ ÛØâØÙ-ØÞÝÝëÙ 
ÐÚÚãÜãÛïâÞà ÕÜÚÞáâìî 1300 Ü°ç á ßàÞÔÞÛÖØâÕÛìÝëÜ ÒàÕÜÕÝÕÜ àÐÑÞâë. 
² ×ÐÒØáØÜÞáâØ Þâ ãáÛÞÒØÙ íÚáßÛãÐâÐæØØ ÐÚÚãÜãÛïâÞà ÞÑÕáßÕçØÒÐÕâ ÒàÕÜï 
àÐÑÞâë âÕÛÕäÞÝÐ Ò àÕÖØÜÕ àÐ×ÓÞÒÞàÐ 4-10 ç, Ò àÕÖØÜÕ ÞÖØÔÐÝØï 80-230 ç.

²Õá ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9210 Communicator á ÐÚÚãÜãÛïâÞàÞÜ áÞáâÐÒÛïÕâ 
244 Ó.
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Ø´ÞàÞÖÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-9

ÀØá. 14

ÁÞÒÕâ. ÍâÞ ×ÐàïÔÝÞÕ 
ãáâàÞÙáâÒÞ ÞáÞÑÕÝÝÞ 
ãÔÞÑÝÞ ßàØ ßÞáâÞïÝÝëå 
ßÞÕ×ÔÚÐå.

´ÞàÞÖÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-9 ÞÑÛÐÔÐÕâ ÜÐÛëÜ ÒÕáÞÜ, 
ßàÞÔÞÛÖØâÕÛìÝëÜ áàÞÚÞÜ áÛãÖÑë Ø àÐÑÞâÐÕâ ßàÐÚâØçÕáÚØ Þâ ÛîÑÞÓÞ áÕâÕÒÞÓÞ 
ÝÐßàïÖÕÝØï. ²Þ ÒàÕÜï ×ÐàïÔÚØ ÚÞÜÜãÝØÚÐâÞàÞÜ ÜÞÖÝÞ ßÞÛì×ÞÒÐâìáï ÚÐÚ 
ÞÑëçÝÞ. ²àÕÜï ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ á ßÞÜÞéìî íâÞÓÞ 
×ÐàïÔÝÞÓÞ ãáâàÞÙáâÒÐ áÞáâÐÒÛïÕâ ßàØÜÕàÝÞ 180 ÜØÝ (Ò ×ÐÒØáØÜÞáâØ Þâ ãàÞÒÝï 
ÞáâÐâÞçÝÞÓÞ ×ÐàïÔÐ ÐÚÚãÜãÛïâÞàÐ).

´Ûï µÒàÞßë ´Ûï ²ÕÛØÚÞÑàØâÐÝØØ
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Ø ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝÐï ÝÐáâÞÛìÝÐï ßÞÔáâÐÒÚÐ 
DCH-10

ÁÞÒÕâ. ´Ûï ×ÐàïÔÚØ 
ÐÚÚãÜãÛïâÞàÞÒ á ßÞÜÞéìî 
íâÞÙ ßÞÔáâÐÒÚØ âàÕÑãÕâáï 
ÔÞàÞÖÝÞÕ ×ÐàïÔÝÞÕ 
ãáâàÞÙáâÒÞ ACP-9. ´Ûï 
ßÞÔÚÛîçÕÝØï Ú ¿º 
âàÕÑãÕâáï ÚÐÑÕÛì ÐÔÐßâÕàÐ 
RS-232 DLR-2L. 
¿ÞÔÚÛîçÕÝØÕ Ú ¿º 
ÒÞ×ÜÞÖÝÞ âÐÚÖÕ çÕàÕ× 
¸º-ßÞàâ. ÀØá. 15

ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝÐï ÝÐáâÞÛìÝÐï ßÞÔáâÐÒÚÐ DCH-10 ÞçÕÝì ãÔÞÑÝÐ ÔÛï

• ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ, ãáâÐÝÞÒÛÕÝÝÞÓÞ Ò ÚÞÜÜãÝØÚÐâÞà;
• ßÞÔÚÛîçÕÝØï ÚÞÜÜãÝØÚÐâÞàÐ Ú ßÕàáÞÝÐÛìÝÞÜã ÚÞÜßìîâÕàã ÔÛï ßÕàÕÔÐçØ 

ÔÐÝÝëå.

½Ð ÛÕÒÞÙ áâÞàÞÝÕ ßÞÔáâÐÒÚØ ßàÕÔãáÜÞâàÕÝ ØÝäàÐÚàÐáÝëÙ ßÞàâ (áÜ. àØá. 15). 
² ßÞÔáâÐÒÚÕ âÐÚÖÕ ßàÕÔãáÜÞâàÕÝÞ ÓÝÕ×ÔÞ ÔÛï ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ, 
ÞâáÞÕÔØÝÕÝÝÞÓÞ Þâ ÚÞÜÜãÝØÚÐâÞàÐ, çâÞ ÞçÕÝì ãÔÞÑÝÞ ÔÛï ×ÐàïÔÚØ ×ÐßÐáÝëå 
ÐÚÚãÜãÛïâÞàÞÒ. 

·ÐàïÔÚÐ ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ á ßÞÜÞéìî 
ÝÐáâÞÛìÝÞÙ ßÞÔáâÐÒÚØ

1 ¿ÞÔÚÛîçØâÕ ßÞàâÐâØÒÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ ACP-9 Ú ßÞÔáâÐÒÚÕ.

ÓÝÕ×ÔÞ ÔÛï ×ÐàïÔÚØ 
×ÐßÐáÝÞÓÞ 
ÐÚÚãÜãÛïâÞàÐ

¸º-ßÞàâ
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Ø2 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà á ãáâÐÝÞÒÛÕÝÝëÜ ÐÚÚãÜãÛïâÞàÞÜ Ò ÝÐáâÞÛìÝãî 

ßÞÔáâÐÒÚã àÐ×êÕÜÞÜ ÒßÕàÕÔ.
3 ²ÚÛîçØâÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ò áÕâÕÒãî àÞ×ÕâÚã.

·ÐàïÔÚÐ ×ÐßÐáÝÞÓÞ ÐÚÚãÜãÛïâÞàÐ á ßÞÜÞéìî ÝÐáâÞÛìÝÞÙ 
ßÞÔáâÐÒÚØ

1 ¿ÞÔÚÛîçØâÕ ßÞàâÐâØÒÝÞÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ú ÝÐáâÞÛìÝÞÙ ßÞÔáâÐÒÚÕ.
2 ÃáâÐÝÞÒØâÕ ×ÐßÐáÝÞÙ ÐÚÚãÜãÛïâÞà ÒÞ ÒâÞàÞÕ ÓÝÕ×ÔÞ ßÞ×ÞÛÞçÕÝÝëÜØ 

ÚÞÝâÐÚâÐÜØ ÒßÕàÕÔ. ÁÝÐçÐÛÐ ßàØÖÜØâÕ ÐÚÚãÜãÛïâÞà ÒÝØ×, ×ÐâÕÜ áÛÕÓÚÐ 
ßÞÔâÞÛÚÝØâÕ ÕÓÞ ÝÐ×ÐÔ ÔÞ ×ÐéÕÛÚØÒÐÝØï.

3 ²ÚÛîçØâÕ ×ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Ò áÕâÕÒãî àÞ×ÕâÚã. ¿àØ íâÞÜ ×ÐÓÞàÐÕâáï 
ØÝÔØÚÐâÞà á ÛÕÒÞÙ áâÞàÞÝë ßÞÔáâÐÒÚØ. ºàÐáÝëÙ æÒÕâ ØÝÔØÚÐâÞàÐ 
ãÚÐ×ëÒÐÕâ, çâÞ ßàÞØáåÞÔØâ ×ÐàïÔÚÐ. ¿ÞáÛÕ ÞÚÞÝçÐÝØï ×ÐàïÔÚØ ØÝÔØÚÐâÞà 
×ÐÓÞàÐÕâáï ×ÕÛÕÝëÜ æÒÕâÞÜ.

4 ´Ûï Ø×ÒÛÕçÕÝØï ÐÚÚãÜãÛïâÞàÐ áÔÒØÝìâÕ ÕÓÞ ÒßÕàÕÔ, ×ÐâÕÜ áÝØÜØâÕ á 
ßÞÔáâÐÒÚØ.

¿àØÜÕçÐÝØÕ. µáÛØ Ò ßÞÔáâÐÒÚÕ ÞÔÝÞÒàÕÜÕÝÝÞ ×ÐàïÖÐÕâáï Ø ÚÞÜÜãÝØÚÐâÞà, 
×ÐàïÔÚÐ ×ÐßÐáÝÞÓÞ ÐÚÚãÜãÛïâÞàÐ ßàØÞáâÐÝÐÒÛØÒÐÕâáï ÔÞ 
ÞÚÞÝçÐÝØï ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ, ãáâÐÝÞÒÛÕÝÝÞÓÞ 
Ò ÚÞÜÜãÝØÚÐâÞà.

¿ÞÔÚÛîçÕÝØÕ Ú ¿º

´Ûï ßÞÔÚÛîçÕÝØï Ú ¿º âàÕÑãÕâáï ÚÐÑÕÛì ÐÔÐßâÕàÐ RS-232 DLR-2L:

1 ¿ÞÔÚÛîçØâÕ ÚÐÑÕÛì ÐÔÐßâÕàÐ Ú àÐ×êÕÜã ÝÐ ×ÐÔÝÕÙ áâÞàÞÝÕ ßÞÔáâÐÒÚØ.
2 ¿ÞÔáÞÕÔØÝØâÕ ÔàãÓÞÙ ÚÞÝÕæ ÚÐÑÕÛï Ú ¿º. 
3 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà Ò ÝÐáâÞÛìÝãî ßÞÔáâÐÒÚã àÐ×êÕÜÞÜ ÒßÕàÕÔ.
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Ø 4 ·ÐßãáâØâÕ ÝÐ ÚÞÜßìîâÕàÕ ßàÞÓàÐÜÜã PC Suite ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 
9210 Communicator ØÛØ ßàØÛÞÖÕÝØÕ ÔÛï àÐÑÞâë á äÐÚá-ÜÞÔÕÜÞÜ.

¼ÞÖÝÞ âÐÚÖÕ ØáßÞÛì×ÞÒÐâì ØÝäàÐÚàÐáÝÞÕ áÞÕÔØÝÕÝØÕ:

1 ²ÚÛîçØâÕ ¸º-ßÞàâë ÚÞÜÜãÝØÚÐâÞàÐ Ø ÚÞÜßìîâÕàÐ.
2 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà Ò ÝÐáâÞÛìÝãî ßÞÔáâÐÒÚã àÐ×êÕÜÞÜ ÒßÕàÕÔ.
3 ÃáâÐÝÞÒØâÕ ßÞÔáâÐÒÚã âÐÚØÜ ÞÑàÐ×ÞÜ, çâÞÑë ¸º-ßÞàâ ßÞÔáâÐÒÚØ ÑëÛ 

ÝÐßàÐÒÛÕÝ ÝÐ ¸º-ßÞàâ ÚÞÜßìîâÕàÐ. ÀÐááâÞïÝØÕ ÜÕÖÔã ÔÒãÜï ¸º-ßÞàâÐÜØ 
ÝÕ ÔÞÛÖÝÞ ßàÕÒëèÐâì 30 áÜ.

4 ·ÐßãáâØâÕ ÝÐ ÚÞÜßìîâÕàÕ ßàÞÓàÐÜÜã PC Suite for Nokia 9210 Communicator 
ØÛØ ßàØÛÞÖÕÝØÕ ÔÛï àÐÑÞâë á äÐÚá-ÜÞÔÕÜÞÜ.

´Ûï áØÝåàÞÝØ×ÐæØØ ÔÐÝÝëå ÜÕÖÔã ÚÞÜÜãÝØÚÐâÞàÞÜ Ø ßàÞÓàÐÜÜÞÙ 
ÞàÓÐÝÐÙ×ÕàÐ ÝÐ ¿º ÔÞáâÐâÞçÝÞ ÞÔØÝ àÐ× ÝÐÖÐâì ÚÛÐÒØèã . 
´ÞßÞÛÝØâÕÛìÝÐï ØÝäÞàÜÐæØï ßàØÒÕÔÕÝÐ Ò àãÚÞÒÞÔáâÒÕ ßÞÛì×ÞÒÐâÕÛï 
ßàÞÓàÐÜÜÝÞÓÞ ÞÑÕáßÕçÕÝØï PC Suite, ÚÞâÞàÞÕ ÝÐåÞÔØâáï Ò àÐ×ÔÕÛÕ “Using 
Nokia 9210 Communicator” ÝÐ ßàØÛÐÓÐÕÜÞÜ Ú ÚÞÜÜãÝØÚÐâÞàã ÚÞÜßÐÚâ-ÔØáÚÕ.
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Ø°ÒâÞÜÞÑØÛìÝëÕ ßàØÝÐÔÛÕÖÝÞáâØ

ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝëÙ ÐÒâÞÜÞÑØÛìÝëÙ 
ÚÞÜßÛÕÚâ ÓàÞÜÚÞÙ áÒï×Ø CARK109

ÀØá. 16
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Ø ÁÞÒÕâ. ²àÕÜï ×ÐàïÔÚØ 
ÐÚÚãÜãÛïâÞàÞÒ áÞÒßÐÔÐÕâ 
áÞ ÒàÕÜÕÝÕÜ ×ÐàïÔÚØ á 
ßÞÜÞéìî 
ÑëáâàÞÔÕÙáâÒãîéÕÓÞ 
ÔÞàÞÖÝÞÓÞ ×ÐàïÔÝÞÓÞ 
ãáâàÞÙáâÒÐ ACP-9.

ÃáÞÒÕàèÕÝáâÒÞÒÐÝÝëÙ ÐÒâÞÜÞÑØÛìÝëÙ ÚÞÜßÛÕÚâ ÓàÞÜÚÞÙ áÒï×Ø CARK109 
ÞÑÕáßÕçØÒÐÕâ ãÔÞÑÝãî ÒÞ×ÜÞÖÝÞáâì ßÞÛì×ÞÒÐâìáï ÚÞÜÜãÝØÚÐâÞàÞÜ 
Ò ÐÒâÞÜÞÑØÛÕ ÑÕ× ÝÕÞÑåÞÔØÜÞáâØ ÔÕàÖÐâì ÕÓÞ Ò àãÚÕ. °ÒâÞÜÞÑØÛìÝëÙ 
ÚÞÜßÛÕÚâ ÞáãéÕáâÒÛïÕâ ßÞÔ×ÐàïÔÚã ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ. º ÜÞÝâÐÖã 
ÐÒâÞÜÞÑØÛìÝÞÓÞ ÚÞÜßÛÕÚâÐ ÔÞßãáÚÐÕâáï âÞÛìÚÞ ÚÒÐÛØäØæØàÞÒÐÝÝëÙ 
ßÕàáÞÝÐÛ. 

ÀØá. 17

² ÚÞÜßÛÕÚâ ÒåÞÔïâ áÛÕÔãîéØÕ ÚÞÜßÞÝÕÝâë: ãÛãçèÕÝÝëÙ ÐÚâØÒÝëÙ 
ÐÒâÞÜÞÑØÛìÝëÙ ÔÕàÖÐâÕÛì CRM-1 (ßÞÚÐ×ÐÝ ÝÐ àØá. 17), 
ãáÞÒÕàèÕÝáâÒÞÒÐÝÝëÙ ÑÛÞÚ ÓàÞÜÚÞÙ áÒï×Ø HFU-2, ÜØÚàÞäÞÝ HFM-8 Ø 
ÒëÝÞáÝÞÙ ÔØÝÐÜØÚ HFS-12. ºàÞÜÕ âÞÓÞ, Ú ÚÞÜßÛÕÚâã ÜÞÖÝÞ ßÞÔÚÛîçØâì 
ÔÞßÞÛÝØâÕÛìÝãî âÕÛÕäÞÝÝãî âàãÑÚã HSU-1, Ð âÐÚÖÕ ÔÞßÞÛÝØâÕÛìÝãî ÐÝâÕÝÝã 
AMD-2, ÚÞâÞàÐï ßÞÒëèÐÕâ ÚÐçÕáâÒÞ áÒï×Ø Ø ãÒÕÛØçØÒÐÕâ àÐÔØãá ÔÕÙáâÒØï 
(ÞÑÐ ÚÞÜßÞÝÕÝâÐ ÝÕÞÑåÞÔØÜÞ ßàØÞÑàÕáâØ ÞâÔÕÛìÝÞ). 

ÃáâÐÝÞÒÚÐ ÚÞÜÜãÝØÚÐâÞàÐ Ò ÔÕàÖÐâÕÛì

1 ·ÐÚàÞÙâÕ ÚàëèÚã ÚÞÜÜãÝØÚÐâÞàÐ Ø ßÞÒÕàÝØâÕ ÐÝâÕÝÝã Ò ×ÐÚàëâÞÕ 
ßÞÛÞÖÕÝØÕ.

2 ÃáâÐÝÞÒØâÕ ÚÞÜÜãÝØÚÐâÞà Ò ÔÕàÖÐâÕÛì ÐÒâÞÜÞÑØÛìÝÞÓÞ ÚÞÜßÛÕÚâÐ 
àÐ×êÕÜÞÜ ÒßÕàÕÔ.
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Ø3 °ÚÚãàÐâÝÞ, çâÞÑë ÝÕ ßÞÒàÕÔØâì àÐ×êÕÜë, ÝÐÖÜØâÕ ÝÐ ÚÞÜÜãÝØÚÐâÞà ÒÝØ× 

ÔÞ ÕÓÞ äØÚáÐæØØ Ò ÔÕàÖÐâÕÛÕ.

¿ÞáëÛÚÐ Òë×ÞÒÐ á ßÞÜÞéìî ÐÒâÞÜÞÑØÛìÝÞÓÞ ÚÞÜßÛÕÚâÐ

1 ²ÒÕÔØâÕ á ÚÛÐÒØÐâãàë âàÕÑãÕÜëÙ ÝÞÜÕà ØÛØ ÒÞáßÞÛì×ãÙâÕáì äãÝÚæØÕÙ 
ßÞØáÚÐ, çâÞÑë ÝÐÙâØ ØÜï Ø ÝÞÜÕà.

2 ½ÐÖÜØâÕ . ² áÛãçÐÕ ÝÕÞÑåÞÔØÜÞáâØ ÚÞÝäØÔÕÝæØÐÛìÝÞÓÞ àÐ×ÓÞÒÞàÐ 
ßÞÔÝØÜØâÕ âÕÛÕäÞÝÝãî âàãÑÚã (ÕáÛØ ÞÝÐ ãáâÐÝÞÒÛÕÝÐ).

¾âÒÕâ ÝÐ Òë×ÞÒ

1 ½ÐÖÜØâÕ  ØÛØ ßÞÔÝØÜØâÕ âÕÛÕäÞÝÝãî âàãÑÚã  (ÕáÛØ ÞÝÐ ãáâÐÝÞÒÛÕÝÐ).
2 µáÛØ Ò ÐÒâÞÜÞÑØÛìÝÞÜ ßàÞäØÛÕ ãáâÐÝÞÒÛÕÝÐ äãÝÚæØï ÐÒâÞÜÐâØçÕáÚÞÓÞ 

ÞâÒÕâÐ, ÚÞÜÜãÝØÚÐâÞà ÐÒâÞÜÐâØçÕáÚØ ÞâÒÕçÐÕâ ÝÐ ÒåÞÔïéØÕ Òë×ÞÒë.

¿ÕàÕÚÛîçÕÝØÕ Ø× àÕÖØÜÐ ØáßÞÛì×ÞÒÐÝØï âàãÑÚØ Ò àÕÖØÜ 
ÓàÞÜÚÞÙ áÒï×Ø

½ÐÖÜØâÕ ÞÔØÝ àÐ× ÚÛÐÒØèã ÒëÑÞàÐ Options (²ëÑÞà) Ø ßÞÛÞÖØâÕ âàãÑÚã Ò 
âÕçÕÝØÕ 5 áÕÚãÝÔ. µáÛØ ÝÕ ÝÐÖÐâì ÚÛÐÒØèã Options ßÕàÕÔ âÕÜ, ÚÐÚ ßÞÛÞÖØâì 
âàãÑÚã, áÒï×ì ÑãÔÕâ ßàÕàÒÐÝÐ.

·ÐÒÕàèÕÝØÕ Òë×ÞÒÐ

½ÐÖÜØâÕ  ØÛØ ßÞÛÞÖØâÕ âÕÛÕäÞÝÝãî âàãÑÚã (ÕáÛØ ÞÝÐ ãáâÐÝÞÒÛÕÝÐ).
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Ø ´ÐâçØÚ ÒÚÛîçÕÝØï ×ÐÖØÓÐÝØï

´ÐâçØÚ ÒÚÛîçÕÝØï ×ÐÖØÓÐÝØï ÞÑÕáßÕçØÒÐÕâ ÐÒâÞÜÐâØçÕáÚÞÕ ÒÚÛîçÕÝØÕ Ø 
ÒëÚÛîçÕÝØÕ ÝÐåÞÔïéÕÓÞáï Ò ÔÕàÖÐâÕÛÕ ÚÞÜÜãÝØÚÐâÞàÐ, ÚÞÓÔÐ ÔÒØÓÐâÕÛì 
ÐÒâÞÜÞÑØÛï ×ÐÒÞÔØâáï ØÛØ ÓÛãèØâáï. ÍâÞ ßàÕÔÞâÒàÐâØâ àÐ×àïÔÚã 
ÐÒâÞÜÞÑØÛìÝÞÓÞ ÐÚÚãÜãÛïâÞàÐ, ÕáÛØ ÚÞÜÜãÝØÚÐâÞà áÛãçÐÙÝÞ ÑëÛ ÞáâÐÒÛÕÝ Ò 
ÔÕàÖÐâÕÛÕ ÝÐ ÔÛØâÕÛìÝÞÕ ÒàÕÜï.

µáÛØ ÔÐâçØÚ ×ÐÖØÓÐÝØï ãáâÐÝÞÒÛÕÝ, ÞÝ àÐÑÞâÐÕâ ßÞáâÞïÝÝÞ. µáÛØ ÔÐâçØÚ 
×ÐÖØÓÐÝØï ÝÕ âàÕÑãÕâáï, ßÞßàÞáØâÕ ÔØÛÕàÐ ÝÕ ãáâÐÝÐÒÛØÒÐâì ÕÓÞ.

¿àØ ÒëÚÛîçÕÝØØ ×ÐÖØÓÐÝØï ÝÐ ÔØáßÛÕÙ ÒëÒÞÔØâáï áÞÞÑéÕÝØÕ “Phone will 
power off, if not used” (µáÛØ âÕÛÕäÞÝ ÝÕ ØáßÞÛì×ãÕâáï, ÕÓÞ ßØâÐÝØÕ ÑãÔÕâ 
ÞâÚÛîçÕÝÞ). ºÞÜÜãÝØÚÐâÞà ÞâÚÛîçÐÕâáï çÕàÕ× 15 á, ÕáÛØ ÝÕ ÝÐÖØÜÐâì ÝØÚÐÚØå 
ÚÛÐÒØè Ø ÝÕ ÒëÝØÜÐâì ÚÞÜÜãÝØÚÐâÞà Ø× ÔÕàÖÐâÕÛï.

¿àØÓÛãèÕÝØÕ ×ÒãÚÐ àÐÔØÞßàØÕÜÝØÚÐ

ÍâÐ äãÝÚæØï ÞÑÕáßÕçØÒÐÕâ ßàØÓÛãèÕÝØÕ ×ÒãÚÐ ÐÒâÞÜÞÑØÛìÝÞÓÞ 
àÐÔØÞßàØÕÜÝØÚÐ ÝÐ ÒàÕÜï âÕÛÕäÞÝÝÞÓÞ àÐ×ÓÞÒÞàÐ (ÕáÛØ âÐÚÐï äãÝÚæØï 
ßàÕÔãáÜÞâàÕÝÐ Ò àÐÔØÞßàØÕÜÝØÚÕ). ¿àØ ãáâÐÝÞÒÚÕ áØáâÕÜë ßÞßàÞáØâÕ ÔØÛÕàÐ 
ÒÚÛîçØâì äãÝÚæØî ßàØÓÛãèÕÝØï ×ÒãÚÐ ßàØÕÜÝØÚÐ.

ÃßàÐÒÛÕÝØÕ íÛÕÚâàÞÔÒØÓÐâÕÛÕÜ ÐÝâÕÝÝë

ÍâÐ äãÝÚæØï (ÕáÛØ ãáâÐÝÞÒÛÕÝÐ) ÞÑÕáßÕçØÒÐÕâ ÒÚÛîçÕÝØÕ íÛÕÚâàÞÔÒØÓÐâÕÛï 
ÐÝâÕÝÝë áÞâÞÒÞÙ áÒï×Ø.
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Ø·ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Þâ ßàØÚãàØÒÐâÕÛï LCH-9

ÀØá. 18

·ÐàïÔÝÞÕ ãáâàÞÙáâÒÞ Þâ ßàØÚãàØÒÐâÕÛï LCH-9 ÞÑÕáßÕçØÒÐÕâ ÛÕÓÚØÙ Ø ãÔÞÑÝëÙ 
áßÞáÞÑ ×ÐàïÔÚØ ÐÚÚãÜãÛïâÞàÐ ÚÞÜÜãÝØÚÐâÞàÐ Ò ÐÒâÞÜÞÑØÛÕ. ·ÐàïÔÝÞÕ 
ãáâàÞÙáâÒÞ ßÞÔåÞÔØâ Ú ÑÞÛìèØÝáâÒã âØßÞÒ ÐÒâÞÜÞÑØÛìÝëå ÓÝÕ×Ô 
ßàØÚãàØÒÐâÕÛÕÙ. ²ÚÛîçØâÕ ßàÞÒÞÔ ÐÒâÞÜÞÑØÛìÝÞÓÞ ×ÐàïÔÝÞÓÞ ãáâàÞÙáâÒÐ 
Ò àÐ×êÕÜ, àÐáßÞÛÞÖÕÝÝëÙ Ò ÝØÖÝÕÙ çÐáâØ ÚÞÜÜãÝØÚÐâÞàÐ.
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Ø ¸ÝÔØÒØÔãÐÛìÝëÕ ÐÚáÕááãÐàë

¼ØÝØÓÐàÝØâãàÐ (ÝÐãèÝØÚ á ßãÛìâÞÜ 
ãßàÐÒÛÕÝØï) HDC-8L

ÀØá. 19

¼ØÝØÓÐàÝØâãàÐ HDC-8L ÞÑÕáßÕçØÒÐÕâ ÒÞ×ÜÞÖÝÞáâì ÚÞÝäØÔÕÝæØÐÛìÝÞÓÞ 
àÐ×ÓÞÒÞàÐ ÑÕ× ÝÕÞÑåÞÔØÜÞáâØ ÔÕàÖÐâì ÚÞÜÜãÝØÚÐâÞà Ò àãÚÕ. Á ßÞÜÞéìî 
ÚÝÞßÚØ ÔØáâÐÝæØÞÝÝÞÓÞ ãßàÐÒÛÕÝØï, ÚÞâÞàÐï àÐáßÞÛÞÖÕÝÐ Ò ÜØÚàÞäÞÝÝÞÙ 
çÐáâØ ÜØÝØÓÐàÝØâãàë, ÜÞÖÝÞ ÞâÒÕâØâì ÝÐ Òë×ÞÒ Ø ×ÐÒÕàèØâì ÕÓÞ. 
¼ØÝØÓÐàÝØâãàÐ ßÞÔÚÛîçÐÕâáï ÝÕßÞáàÕÔáâÒÕÝÝÞ Ú àÐ×êÕÜã Ò ÝØÖÝÕÙ çÐáâØ 
ÚÞÜÜãÝØÚÐâÞàÐ.
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Ø¿ÞïáÝÞÕ ÚàÕßÛÕÝØÕ BCH-17

ÀØá. 20

¿ÞïáÝÞÕ ÚàÕßÛÕÝØÕ BCH-17 — íâÞ ãÔÞÑÝëÙ áßÞáÞÑ ßÕàÕÝÞáÚØ ÚÞÜÜãÝØÚÐâÞàÐ, 
ÚÞÓÔÐ ÚÞÜÜãÝØÚÐâÞà ÔÞÛÖÕÝ Ñëâì ßÞáâÞïÝÝÞ ßÞÔ àãÚÞÙ.

ÇÕåÞÛ ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ

ÀØá. 21

ÍâÞâ çÕåÞÛ ßàÕÔÝÐ×ÝÐçÕÝ áßÕæØÐÛìÝÞ ÔÛï ßÕàÕÝÞáÚØ ÚÞÜÜãÝØÚÐâÞàÐ Nokia 
9210 Communicator Ø ßÞáâÐÒÛïÕâáï ÔØÛÕàÐÜØ Nokia.
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Ø ¼ÞÑØÛìÝëÙ ÞäØá

ºÐàâÐ ßÐÜïâØ
ºÐàâÐ ßÐÜïâØ àÐ×ÜÕàÞÜ á ßÞçâÞÒãî ÜÐàÚã ßàÕÔáâÐÒÛïÕâ áÞÑÞÙ áêÕÜÝÞÕ 
ãáâàÞÙáâÒÞ åàÐÝÕÝØï ÔÐÝÝëå ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ. ºÐàâÐ ßÐÜïâØ ßÞ×ÒÞÛïÕâ 
ãÒÕÛØçØâì ÞÑêÕÜ ßÐÜïâØ, ÔÞáâãßÝÞÙ ÔÛï åàÐÝÕÝØï ÔÐÝÝëå Ø ßàÞÓàÐÜÜ. 
½ÐßàØÜÕà, ÜÞÖÝÞ ×ÐÓàãÖÐâì Ò ÚÞÜÜãÝØÚÐâÞà ÝÞÒëÕ ßàØÛÞÖÕÝØï, Ð âÐÚÖÕ 
áÞåàÐÝïâì àÐ×ÛØçÝëÕ äÐÙÛë (Ø×ÞÑàÐÖÕÝØï, ×ÒãÚÞÒëÕ äÐÙÛë, äÐÚáë Ø 
ÔÞÚãÜÕÝâë). ºÐàâã ßÐÜïâØ ÜÞÖÝÞ ØáßÞÛì×ÞÒÐâì ÔÛï åàÐÝÕÝØï àÐ×ÛØçÝëå 
ßàØÛÞÖÕÝØÙ ØÛØ ÐÔàÕáÝëå ÚÝØÓ.

¿àØÜÕçÐÝØÕ. ºÐàâë ßÐÜïâØ, ßàÕÔÝÐ×ÝÐçÕÝÝëÕ ÔÛï ÚÞÜÜãÝØÚÐâÞàÐ Nokia 
9210, ÝÕ áÞÒÜÕáâØÜë áÞ áâÐàëÜØ ÜÞÔÕÛïÜØ 
ÚÞÜÜãÝØÚÐâÞàÞÒ Nokia, ÞÔÝÐÚÞ ÚÐàâë ßÐÜïâØ Þâ 
ÚÞÜÜãÝØÚÐâÞàÐ Nokia 9110i ÜÞÖÝÞ ØáßÞÛì×ÞÒÐâì Ò 
ÚÞÜÜãÝØÚÐâÞàÕ Nokia 9210 ßÞáÛÕ äÞàÜÐâØàÞÒÐÝØï.
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ØºÐÑÕÛì ÐÔÐßâÕàÐ RS-232 DLR-2L

ÀØá. 22

ÍâÞâ ãÝØÒÕàáÐÛìÝëÙ ØÝâÕàäÕÙáÝëÙ ÚÐÑÕÛì ÞÑÕáßÕçØÒÐÕâ ÒÞ×ÜÞÖÝÞáâì 
ßÞÔÚÛîçÕÝØï Ú ßÕàáÞÝÐÛìÝÞÜã ÚÞÜßìîâÕàã ÔÛï ÞÑÜÕÝÐ ÔÐÝÝëÜØ 
á ÚÞÜÜãÝØÚÐâÞàÞÜ Nokia 9210 Communicator. ºÐÑÕÛì ßÞÔÚÛîçÐÕâáï 
Ú ßÞáÛÕÔÞÒÐâÕÛìÝÞÜã ßÞàâã RS-232 ßÕàáÞÝÐÛìÝÞÓÞ ÚÞÜßìîâÕàÐ. ºÐÑÕÛì 
ÜÞÖÝÞ âÐÚÖÕ ØáßÞÛì×ÞÒÐâì á ãáÞÒÕàèÕÝáâÒÞÒÐÝÝÞÙ ÝÐáâÞÛìÝÞÙ ßÞÔáâÐÒÚÞÙ 
DCH-10.


